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Figure: The GeoMapApp base map reveals striking features of Mt. St. Helens, a stratovolcano in the Cascade Range. Inset, top 
left: Profile taken across the summit caldera. Inset, lower right: 3-D perspective plot looking south towards the blasted away 
northern flank. Resolution of elevation data set is 10m. 
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    User Guide for GeoMapApp v3.7.1 

Page 4 of 164 

1) About GeoMapApp 
 

GeoMapApp is an application created for the discovery, exploration, manipulation, visualization and 
analysis of a large choice of built-in and user-imported geoscience data. The application is coded in Java 
and runs on the Windows, Mac, Linux, and UNIX operating systems. GeoMapApp is free and can be 
downloaded at http://www.geomapapp.org/. The development of GeoMapApp is funded by the US 
National Science Foundation and by the Trustees of Columbia University.  
 
The GeoMapApp interface provides users with access to many built-in data sets as well the ability to 
import their own locally-stored data sets. The GeoMapApp tool bar provides a number of useful 
functions and shortcuts, including zoom and panning, a profile tool and a mask function, and a digitizer. 
When viewing grids, the grid pop-up window offers convenient tools for changing the color palette, sun 
illumination and vertical exaggeration, for drawing contours and creating profiles, and for generating a 
3-D perspective view. A Save Session function allows an instance of GeoMapApp to be saved and shared 
with students and colleagues. At all times, the GeoMapApp layer manager allows layers to be toggled off 
and on, their transparency altered, and their order switched. For example, varying the transparency is 
useful when comparing co-located data sets, and, when viewing multiple data sets, the user can specify 
which layer is topmost. A number of built-in data sets are shapefiles. The shapefile manager allows 
individual components of built-in and imported multi-shape shapefiles to be selected. 
 

A collection of short GeoMapApp video tutorials is posted on , under the GeoMapApp 
channel, as captured in this screen shot: 
 

  
 

Also, answers to a list of frequently-asked questions are given on the GeoMapApp web page and are 
routinely updated. 
 

http://www.geomapapp.org/
http://www.youtube.com/user/GeoMapApp?feature=watch
http://www.youtube.com/user/GeoMapApp?feature=watch
http://www.geomapapp.org/FAQ.html
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2) Download and start GeoMapApp 

 

See video tutorial on  
 
On the GeoMapApp web page (http://www.geomapapp.org/), look in the left pane and choose the 
platform you are using from the Download Links area. 

                       
 
Click Agree and save the application to the local computer. Double-click on the icon to start the 
application.  
 
Alternatively, if GeoMapApp was downloaded as a jar file (GeoMapApp.jar), it can be opened from a 
terminal window by changing to the directory containing the application and typing, for example: java -
jar -Xmx1028m GeoMapApp.jar    In this example, 1028 Mbytes are allocated as application memory 
(the default is 512 Mbytes). Specifying a larger memory size is useful when importing very large (many 
100s MBytes) grids or data sets from the local disk drive. 
 
A third way of opening GeoMapApp is to use a Java WebStart link. The WebStart link is given on the 
GeoMapApp home web page and allows GeoMapApp to be opened directly from the internet using a 
Java-enabled web browser. 
 

2.1) Choosing a Map Projection 
 
When GeoMapApp is opened, the user has a choice of three map projections as shown below, left. 

         
 
The Mercator projection – the leftmost panel – is the pre-selected default as shown by the outlined blue 
border. Click the center panel for the southern hemisphere polar projection or the rightmost panel for 

the northern hemisphere polar projection.  Click the  button to proceed. An initialisation 
screen (above, right) is displayed briefly before the GeoMapApp window appears. 
 

http://www.youtube.com/watch?v=aCyskQ7ngUM
http://www.geomapapp.org/
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Most of the built-in data sets are common to all three projections although some data sets are unique to 
certain projections. 
 
The Mercator projection conforms to the map projection standard called European Petroleum Survey 
Group code 3395, the Southern hemisphere polar projection to EPSG code 3031 and the Northern 
hemisphere projection to EPSG code 32661. The default Mercator projection extends from 81°S to 81°N. 

 

2.2) The GeoMapApp window 
 
After the GeoMapApp window has opened, the default map on display is shaded color topographic relief 
from the Global Multi-Resolution Topography (GMRT) synthesis of the Marine Geoscience Data System. 
Here are screenshots of the three projections. 

 

  
Figure: Mercator projection base map (default) 
 

     
Figure: Southern hemisphere projection         Figure: Northern hemisphere projection 
 
Go to Table of Contents 

  

https://www.gmrt.org/
http://www.marine-geo.org/
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3) Global Multi-Resolution Topography (GMRT) 
 
The GMRT global elevation synthesis (Ryan et al., 2009) is the default base map in GeomapApp.  
 
GMRT includes multibeam swath bathymetry from more than 1,000 research cruises. In the oceans, the 
default maximum horizontal resolution on a global scale is ~100m, with 50m grid spacing in some shelf 
areas, and even higher resolutions in concentrated study areas such as hydrothermal vent fields.  
 
For land areas, high-resolution elevation data from the Shuttle Radar Topography Mission and USGS 
NED model are included.  
 

 

 
Figure: Examples of the GMRT compilation at the East Pacific Rise 9N site. Progressively higher resolution 
is shown to the lower right. The mask function (middle image) uses transparency to indicate areas with 
multibeam swath bathymetry data. The underlying GMRT grid can shaded to highlight the strong abyssal 
hill fabric (lower right). 
 
Go to Table of Contents 
  

https://www.gmrt.org/
http://dx.doi.org/10.1029/2008GC002332
http://www2.jpl.nasa.gov/srtm/
http://ned.usgs.gov/
http://ned.usgs.gov/
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4) The Menu Bar - Introduction 

 
Built-in and imported data sets and many other functions are accessed through the menu bar. 
 

 
 

The File menu ( ) provides user import options for Excel™ spreadsheets, data tables, grids, 
shapefiles, and images and offers Web Service connections to data from a number of national and 
institutional data repositories including IRIS, NASA, JPL, UNAVO, NSIDC. Various save and export options 
are available, including Save Session. 
 

The DataLayers menu ( ) presents a wide range of built-in global, regional and local data 
sets. The menu items clumped into the following categories. 

  
 
The categories were chosen to reflect big-picture geoscience fields and themes. For example, 
Cryosphere includes data sets related to polar ice studies and glaciations; Geophysics includes data sets 
ranging from lithospheric plate deformation, earthquake catalogues, gravity and magnetic anomalies, 
tomographic seismic velocity models, to heat flow data. The Geology category includes geological maps 
and interpretations, volcano catalogues, and seafloor characteristics.  
 
Two examples of the many built-in data sets available under the DataLayers menu are given in the figure 
below.  
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Figure: Examples of built-in GeoMapApp data sets. (clockwise from upper left): Geology map of France; 
Cross-section of the subducting slab interface beneath the Andes (Syracuse and Abers, 2006) with the 
profile taken across the white E-W-trending line shown in the lower map. Also plotted on that map are 
global earthquakes (1973-2013) with magnitude > 5.5 in which epicenter locations are colored on focus 
depth (cooler colors are shallower) and scaled on magnitude. 
 
 

The Portals menu ( ) offers customized interfaces to access and manipulate specific data types. 
For example, the Digital Seismic Reflection Profiles interface allows users to view and digitize Multi-
Channel Seismic Reflection profiles; the Ocean Floor Drilling interface provides customized profiling and 
searching of sediment core data from the DSDP, ODP and IODP programs; the Seafloor Photographic 
Transects portal offers seafloor dive photos arranged along dive tracks; and, the GPS Velocity Vectors 
portal allows users to plot user-defined velocity vectors on the map. 
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Figure: Examples of customized interfaces available under the Portals menu: (Clockwise from upper left) 
Seafloor dive photos on high-resolution bathymetry for the EPR 9N Ridge 2000 study site; the DSDP/ODP 
interface includes species range charts, down-hole physical measurements and stratigraphic information; 
Multi-Channel Seismic reflection profiles across the Aleutian trench. 
 

 
Figure: The Search Expedition Data portal provides a convenient map interface to search on cruise-
related data. An alternative map-based cruise data search interface is now also available at 
http://www.marine-geo.org/tools/new_search/search_map.php 

http://www.marine-geo.org/tools/new_search/search_map.php
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The Focus Sites menu ( ) provides quick links to GeoPRISMS, Ridge 2000,  and MARGINS 
Focus Site data sets as well as to data sets for other selected areas. 
 

In the Overlays menu ( ), various overlays can be selected and toggled on/off, including a 
distance scale, the inset map, coastlines, lakes and rivers, latitude/longitude grid lines, and 
geographic/political names and boundaries. 
 

The Bookmarks menu ( ) allows the current view to be saved as a bookmark, provides 
zooming capability to user-specified areas, and a shortcut to zoom out to the global view. 
 

Education-related links are given under the Education menu ( ). 

 

The Windows menu ( ) can be used to bring-to-front any of the GeoMapApp pop-up or control 
windows that are currently open.  
 

The Projection menu ( ) offers a shortcut to switch from one GeoMapApp projection to 
another without needing to close and re-open the program. 

 

The Help menu ( ) points users to this user guide document, to a wide range of GeoMapApp video 

tutorials hosted on , to an FAQ page, and to other help-related resources. 

 
 
When the Save Session function is active, a new menu item called My Layer Sessions (

) appears at the end of the menu bar: 
 

 
 
The Save Sessions function currently offers basic capability useful for collaboration and teaching. For 
example, educators can preserve a pre-loaded state of GeoMapApp, and, when shared with a class, the 
saved file allows every student to open GeoMapApp at exactly the same starting point from which to 
begin their data explorations.  
 
Go to Table of Contents 

 
 
  

https://www.youtube.com/user/GeoMapApp/videos
https://www.youtube.com/user/GeoMapApp/videos
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5) The Menu Bar - Details 
 
In this section are the details of each of the menus. 

 

5.1) File 
 

 
 
Functions under the File menu include data import, save options, Save Session, and GeoMapApp 
settings preferences. 

 

 
 
 
5.1.1) Import data sets – Import Dataset from Web Feature Service (WFS) 
 
Provides real-time web connection to a wide range of database and repository holdings, including those 
at NGDC, IRIS, the Antarctic Master Directory, the PetDB petrological database and SedDB sediment 
geochemistry database, DSDP, and others. 

 
When a WFS data set is loaded, all functionality associated with tabular data sets is available, 
such as choice of plotting symbol, symbol coloring and scaling, graphing, and lasso selection.  
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Figure: An IRIS Web Feature Service (WFS) data set for earthquake locations showing those around 
Indonesia, colored according to magnitude.  
 
To graph the down-hole measurements associated with the DSDP WFS, see the data set Special 
Functionality section.  
 
 

5.1.2) Import data sets – Import Image from Web Map Service (WMS) 
 
Provides real-time web connection to a number of agencies serving images and maps via WMS, 
including NASA, JPL and NSIDC. OGC standard WMS versions 1.0.0, 1.1.0, 1.1.1 and 1.3.0 are supported. 
To specify a particular version, add it to the GetCapabilities URL. Example: 
http://coastalmap.marine.usgs.gov/cmgp/National/gloria/MapServer/WMSServer?request=GetCapabili
ties&service=WMS&version=1.3.0 
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Figure: Web Map Service examples. Clockwise from upper left: Outgoing long wave radiation (NASA, 
CERES); One month of fires across eastern Africa (NASA, Terra/MODIS); Extent of sea ice in austral 
summer (NSIDC, for December 1979-2007); Landsat5 pseudo-color mosaic (JPL, CONUS data set). 
 

5.1.3) Import data sets – Import a 2-D Grid File  
 

See video tutorial on  
 
With this function, users may import their own grids and have full capability for zooming, grid 
manipulation and profiling. Various formats of grids can be imported, including the GMT netCDF and 
ESRI ASCII/binary formats. Multiple grids can be imported at once. 
 

5.1.4) Import data sets – Import Shapefile 
 

See video tutorial on  
 
Use this option to import shapefiles. The required shapefile components are the .shp, .shx and .dbf files 
as described here.  

 
5.1.5) Import data sets – Import Table or Spreadsheet 
 

See video tutorial on  
 

http://www.youtube.com/watch?v=JnXJ-Y8Ry0s
http://gmt.soest.hawaii.edu/
http://www.unidata.ucar.edu/software/netcdf/
http://en.wikipedia.org/wiki/ESRI_grid
http://www.youtube.com/watch?v=noRwgqiEYC4
http://www.geomapapp.org/database/Importing_Data.html
http://www.youtube.com/watch?v=P4v2Mfz32X4
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Users can import data tables that are in ASCII and Excel
TM

 formats as well as tables stored on the 

clipboard or at a given web URL. Excel
TM

 spreadsheets must be in a recent format such as Microsoft 
1997-2007 or .xlsx format. The data table must contain a column for longitude (in decimal degrees) and 
a column for latitude (in decimal degrees). The imported points are plotted on the map and can be 
manipulated as for any tabular data set – colored, scaled, graphed, linked to URLs, and so on.  
 
Additionally, specific symbol colors can be predefined by including a column of RGB (Red,Green,Blue) 
values in the data table. The RGB values need to be listed as comma-separated triples such as 
255,140,67. Upon import, the RGB column is specified in the import Config window. 

 
5.1.6) Import data sets – Add Image Overlay 
 

See video tutorial on  
 
Imported images are displayed in the GeoMapApp window. The transparency function in the Layer 
Manager can be used to compare the imported image with underlying data sets. 

 
5.1.7) Preferences 
 
The preferences window contains functions that control the border annotation location and style as well 
as the ability to turn off and on and clear the caching of menus and portal databases. 
  

 
 
For border annotations, select the Map Border tab, and tick or untick boxes to turn items on and off. 

Select font type from the drop-down menu. Type a new font size in the box . To check the 

appearance of changes to the annotations, select Then, to accept the changes, select 

. 
 

The caching options, listed under the Cache Options tab , are turned on by default 
since they typically greatly reduce the time taken for GeoMapapp to start and for certain portal 
interfaces to load. For example, with no caching, the Multibeam swath bathymetry portal may take up 
to 2-3 minutes to fully load. When portal caching is turned on, subsequent re-loads of the portal takes 
just 2-3 seconds.  

http://www.youtube.com/watch?v=QCylN5BpFsU
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The menus are cached by default but can be cleared with the  button. The next 
time GeoMapApp is started a fresh copy of the current menus will be obtained automatically from the 
server. 
 

The   tab is used for previewing and assessing edited multibeam swath bathymetry tiles as 
part of the GMRT work flow. This tab is mainly used for internal purposes by the GMRT team.  
 

 
 
The Server Options tab is for internal use. 

 
5.1.8) Session Manager 
 
The Session Manager allows a pre-loaded state of GeoMapApp to be preserved. When the saved session 
file is later imported – for instance, by students or colleagues – GeoMapApp automatically opens to the 
same state with the same data layers loaded, the same color palettes and layer transparency settings, 
and with the same zoom. Sharing a saved session file could be useful in a classroom setting to have all 
students open GeoMapApp at exactly the same state. The Session Manager menu offers the following 
options: 

 
 
Save the current display using Save Current Session. The information is stored in a simple XML file on the 
local machine. 
 
Use Import Saved Session (.xml) to bring up a navigation window that provides access to saved sessions. 
When a saved session has been selected and imported, a new menu item pops up in the top of the 
GeoMapApp window: 

 

https://www.gmrt.org/about/news.php
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Click on My Layer Sessions to see the list of imported sessions. Each listed item shows the individual 
component data sets of that saved session. When one of the component data sets is selected, it is 
loaded in GeoMapApp. 
 
Refresh Imported Sessions will re-read the list of saved sessions to ensure that it is up-to-date. 

 removes the  menu from the top of the 
GeoMapApp window.  
 
See also the My Layer Sessions section and the How to Save a Session section. 
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5.1.9) Save Map Window as Image/Grid File 
 
The current map view (including any symbols, grids, tracks and so on that are displayed) can be saved in 

various image formats including JPEG, PNG, KMZ (Google Earth
TM

-compatible), and GeoTIFF. The image 
can also be stored as a PDF file (see Print option below).  
 
When the GMRT base map is loaded, the Grid: Higher Resolution Options save function allows the 
GMRT base map to be saved in a gridded format at user-specified scales of resolution.  
 

When any grid has been loaded, the range of grid save options includes GMT netCDF, ESRI ASCII/binary, 
and GeoTIFF formats. 
 
The Color Scale bar for the base map or for any loaded grid may also be saved using the Save Color Bar 
option in this menu, as shown here: 
 

 
 

5.1.10) Print Map Window  
 

Sends current map view to a printer or to a PDF file. Click the Printer  button to choose the 
destination printer (or to save to PDF). Paper orientation and margins can also be specified. 
 

5.1.11) Exit 
 
Close GeoMapApp. 
 
 
Go to Table of Contents 
 
  

http://www.jpeg.org/
http://en.wikipedia.org/wiki/Portable_Network_Graphics
http://en.wikipedia.org/wiki/Keyhole_Markup_Language
http://earth.google.com/
http://en.wikipedia.org/wiki/GeoTIFF
http://www.adobe.com/products/acrobat/adobepdf.html
https://www.gmrt.org/
https://www.gmrt.org/
http://gmt.soest.hawaii.edu/
http://www.unidata.ucar.edu/software/netcdf/
http://en.wikipedia.org/wiki/ESRI_grid
http://en.wikipedia.org/wiki/GeoTIFF
http://www.adobe.com/products/acrobat/adobepdf.html
http://www.adobe.com/products/acrobat/adobepdf.html
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5.2) DataLayers 
 

 
 
A wide range of built-in global, regional, and local data sets covering many geoscience disciplines are 
available through the new DataLayers menu.  
 
The DataLayers menu presents thousands of research-grade geoscience data layers that have been 
arranged in the following categories. 

 
 
The categories were chosen to reflect big-picture geoscience fields and themes. For example, 
Geophysics includes data sets ranging from lithospheric plate deformation, earthquake catalogues, 
gravity and magnetic anomalies, tomographic seismic velocity models, to heat flow data. The Geology 
category includes geological maps and interpretations, volcano catalogues, and seafloor characteristics. 
Cryosphere includes data sets related to polar ice studies and glaciations, whilst Climatology contains 
hurricane data, palaeo-climate reconstructions, and land/ocean temperatures. 
 
In general, the data sets within each menu are organised from the global scale down to the regional and 
local scale. For example, the Bathymetry and Land Topography menu includes global elevation models 
such as GMRT and GEBCO; regional-scale data sets; and many high-resolution data sets for small study 
areas. Land elevations include very-high-resolution LiDAR data sets such as 3m-horizontal-resolution 
topographic elevations for some Cascade volcanoes, and a 1-foot data set of New York City. 
 
New data sets are added to the DataLayers menus throughout the year. Existing data sets are also 
updated as needed. They additions and updates are listed on the Recently-Added Data Sets web page. 
The GeoMapApp menus automatically update during start-up to include new additions.  
 
 

  

https://www.gmrt.org/
http://www.gebco.net/data_and_products/gridded_bathymetry_data/
http://www.geomapapp.org/data_set_news.html
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5.2.1) Layer Manager 
 
A Layer Manager window opens automatically when any data set is loaded. It can be used to turn the 
loaded layer off and on, to alter its transparency, to change the ordering of loaded layers, and to discard 

it entirely. If the Layer Manager window is not visible, activate it by clicking the  icon in the 
GeoMapApp toolbar. 
 
 

5.2.2) Gridded Data 
 
When a gridded data set is loaded, a grid dialog window appears. For grids that comprise a multi-shape 
shapefile, a Shapefile Manager also comes up, allowing individual shapefile components to be selected. 

 

  
Figure: High-resolution bathymetry of San Francisco Bay shows fine detail of bay bottom ripples and a 
dredge channel. The grid dialog window (shown to the right) provides functions to manipulate the grid 
including changing the colors, sun illumination, contours, and taking profiles. This bathymetry data set is 
available through DataLayers > Bathymetry and Land Topography > Bathymetry - By Region > US Bays, 
Coast, Estuaries, and Harbours > Washington, Oregon, and California (Q-Z) > San Francisco Bay Interior 
(5m resolution). 
 

See video tutorial on  
 
 
 

https://www.youtube.com/watch?v=DBtj_EdMJDM
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5.2.3) Tabular Data (Spreadsheet, Table, CSV file, etc)  
 

See video tutorial on    See also section (10) of this User Guide for more details on handling and 
manipulating tabular data.  
 
Spreadsheets, tab-separated ASCII files, and CSV files are examples of tabular data formats. The 
DataLayers menu contains many built-in data sets that are in a tabular format.  Common to all of these 
tabular data sets is that each record in each tabular data set is geographically-referenced by longitude 
and latitude. This allows individual points to be queried and manipulated.  
 
All tabular data manipulation functions described below and in section (10) apply to the built-in tabular 
data sets and to any imported tabular data set, whether imported as a spreadsheet, ASCII table, or from 
the clipboard.  
 

 

http://www.youtube.com/watch?v=xjMNvzpQc3k
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Figure: Example of three built-in tabular data sets displayed in GeoMapApp. Red triangles show 
volcanoes from the Smithsonian Global Volcanism Program, v4.3.4. Earthquakes from the USGS 
catalogue for the period 1960-2021 are shown as circles that are coloured on hypocentral depth and 
scaled on magnitude. Squares are EarthChem geochemical data coloured on Al203. The graph window 
shows an EarthChem scatter plot with MgO plotted against SiO2. The colors are easily changed by 
moving the grey vertical lines in the colour histogram windows. The colour legends can be saved. In the 
lower right is the Layer Manager window. The symbol chosen for each tabular data set (circle, square, 
triangle or star) is displayed next to the up/down arrows in the Layer Manager. For symbols that are 
dynamically coloured, the symbol in the layer Manager will be grey. For symbols that are uniformly 
coloured using the Configure colouring options, those symbols are show in the Layer Manager with the 
specified colour.  
 
For large data sets, GeoMapApp displays a notice if there are more than 20,000 points asking if all points 
should be plotted or if only a decimated sub-set should be shown. In this example, the data set contains 
162,843 records: 
 

 
 
If Plot All Records is chosen, all of the points will be plotted on the map. For very large data sets, more 
memory may need to be allocated to GeoMapApp – see the details in the Download and start 
GeoMapApp section. 
 
If Plot Geographically-Decimated Subset is chosen, all of the records will be read into operating memory 
but no more than 20,000 points will be plotted in the map window. The displayed decimated points are 
chosen to be representative of the geographical distribution of the entire data set although some quirks 
are known to occur. Upon zooming in, more of the points become visible. 
 
Although most modern computers tend to contain high-performance graphics cards, the decimation 
option is still provided for very large data sets. 
 
Once the tabular data set has loaded, the data records are displayed beneath the map. Points can be 
selected either by clicking one row in the table (the row will turn to a blue color, example: 

) or by clicking one of the symbols on the map which 
will turn red and will, in turn, highlight the corresponding record in the table: 
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To select more than one point, either shift-click to select multiple consecutive points in the table, ctrl-

click to select multiple non-consecutive points in the table, or, use the Lasso Tool ( ) to 
draw around points on the map. Various options are provided for saving the selected records. 
 
Some tabular data sets contain many columns so scroll to the right in the table to see all of the cells. 
Many of the data set tables contain URL hyperlinks to more information. The link is often given at the 
end of the row so scroll to the right. 
 

 
Figure: The Lamont Core Repository data is one example of a built-in tabular data set (clockwise from top 
left): After selecting one point (highlighted as a red dot north of Brazil), the URL at the end of the row 
opens a web page containing more information (bottom right). In the lower left image, the Lasso Tool      

( ) has been used to select multiple points - all selected points are shown in red. 
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Sort a column by clicking the column header. Drag columns to the left or right to rearrange them. 
Change the column width by moving the column separators sideways. 
 
Basic functions allow numerical columns in the built-in or imported data sets to be manipulated, 
including colored by value, scaled, and graphed. The display parameters are preserved each time a new 
data set is loaded. This allows multiple tabular data sets to be displayed at once.  
 

When symbols are colored, the color histogram window offers a  button. More than 
sixty color palettes are currently available. Clicking the button generates a color legend in a separate 

window. The legend can be saved as a JPEG image with the  button. 
 

See video tutorial on and here for examples of manipulating data sets. 
 
 

5.2.4) Legends 
 
A number of built-in data sets, such as the state geological maps, have an associated legend. Some 
legends are automatically loaded, as in the example below. 
 

  
Figure: AVHRR sea surface temperature data set loaded in GeoMapApp. Zoom in to see finer detail. The 
map legend appears automatically and can be resized and moved. 

Other legends will be displayed if there is a Legend button in the Layer Manager window and it is 

clicked. The legend button, if present, is sited between the Information  button and the  Zoom 
button in the Layer Manager: 

 

http://www.youtube.com/watch?v=Hkm-FCd-v9o
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5.2.5) Tear-Off Menus 
 
Items in the DataLayers, Portals, FocusSites, Overlays, and Education menus, can be selected either by 
following the cascading drop-down menus or by selecting the tear-off menu option. The latter opens a 
separate menu window that may offer easier navigating. The tear-off menu option, colored orange, is 
the first item in each menu, as show in this example: 
 

 
 

 
 
See the How to use the Tear-Off Menus for more details on the tear-off menus, and menu searching. 
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5.2.6) Special functionality for some tabular data 
 
Under the DataLayers menu, the Water Column Properties > World Data set of Temperature, Salinity, 
Oxygen, Nutrient Profiles (Reid and Mantyla, 1994) data records are each associated with a number of 

water column properties. Click once on a URL in the  column to display the water column 
properties as a table in a web browser. 

 
 
To plot these properties as profiles, select one record in the table and control-shift-click on the URL 
(hold down the control and shift keys, and at the same time click the URL with the mouse). This brings 
up a separate graph window.  

 
 

The y-axis can be flipped ( ) to put the sea surface at the top. 
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To compare profiles side-by-side, select the Add Graph menu ( ) and choose which 
parameter to plot. The new graph can be deleted by clicking  (upper right corner). Add more graphs as 

needed. The water column values can be saved to a tabular text file (  button). 

 
 

 
Figure: Reid and Mantyla’s water column properties compilation interface offers enhanced functionality. 
Click once on the URL to open the table of data (upper right). Press control-shift-click on the URL to open 

the graphing window (right middle). Flip the y-axis ( ) to put the ocean surface at the top of 

the graph, and add more graphs ( ). Multiple profiles are plotted 
side-by-side (bottom). 

 
 
Go to Table of Contents 
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5.3) Portals 
 

 
 
The Portals menu provides customized interfaces for a number of specific data types shown in the menu 
below. The expanded functionality of each Portal allows greater data manipulation and access. 
 

 
 
In the following sections, the functionality of each portal is described in detail. 
 
 
Go to Table of Contents 
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5.3.1) Bathymetry, Gravity and Magnetic Anomaly Profiles 
 

See video tutorial on  
 
This customized interface allows users to view underway along-track geophysical profiles of gravity, 
magnetics and bathymetry data for more than 8,700 research cruises spanning decades of exploration 
from the underway collections of NCEI/NGDC, LDEO, USAP, and SIOExplorer. 
 

Select this interface from the Portals menu ( ) to display the ship tracks. The default view displays 
the NCEI/NGDC holdings of cruise tracks with any gravity, magnetics or bathymetry data. Click the LDEO 
or USAP or SIO button to display that catalogue. To select cruises for a particular data type, use the 
check boxes to the right of the map: tick only those boxes for which data is required. 

 

 
Figure: Use the tick boxes and radio buttons on the right to choose which data collection and data type 
are displayed on the map.  
 
Zoom to an area and click on a track of interest. The selected track turns white and the cruise ID is 
highlighted in the list in the lower left. Note that only those cruises falling both within the map area and 
having the selected data type are displayed in the cruise list in the lower left.  

http://www.youtube.com/watch?v=R6YNavWKcWw
http://www.ngdc.noaa.gov/mgg/geodas/trackline.html
http://www.marine-geo.org/tools/new_search/index.php
http://www.usap-data.org/
http://siox.sdsc.edu/collections.php
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Select View Profile ( ) to load the underway along-track geophysical data. The selected 
track line on the map turns yellow. The red part of the track shows the extent of the profile displayed in 
the lower pane. Note that it may be necessary to scroll horizontally through the profile window to see 
profiles for incomplete data sets.  
 
Download the underway along-track geophysical data set for the selected cruise in either MGD77 or CSV 

comma-separated ASCII format using the Download Data button ( ). To download 
data for multiple cruises, use shift-click or ctrl-click to select the cruises from the list in the lower left.  
 

The Save Displayed Profile button ( ) allows the profile to be saved as an image 
and allows the profile data to be saved as a CSV ASCII file. Either the full along-track profile for the entire 
cruise or just the segment displayed in the profile window (the “viewport”) may be saved. Choose the 
extent by ticking one of the boxes and choose the output format by clicking one of the radio buttons.   

 
 
Note that when zoomed in, the profile may need to be scrolled sideways to see the data. If no data is 
visible in the profile window, the downloaded CSV file will be empty.  
 

Use the   button to import an MGD77 file. Both the legacy MGD77 
format and the newer tab-delimited MGD77T format are supported. Header and data files may be 
imported separately and file name extensions of .a77, .m77, .m77t, .mgd77, .mgdt77, .h77 and .h77t are 
automatically identified. 
 

Save the track map as an image using  > . 

 

http://www.ngdc.noaa.gov/mgg/dat/geodas/docs/mgd2000.htm
https://www.ngdc.noaa.gov/mgg/dat/geodas/docs/mgd2000.htm
https://www.ngdc.noaa.gov/mgg/dat/geodas/docs/mgd2000.htm
https://www.ngdc.noaa.gov/mgg/dat/geodas/docs/mgd2000.htm
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Figure: In this example, Conrad cruise RC2608 was selected by clicking the track line in the map window 

(it could also have been chosen from the list in the lower left). The View Profile button ( ) 
loads the data in the profile window. Use the gravity, magnetics, bathymetry radio buttons to display 
that data set for the selected track. In this case, gravity is displayed in the profile to reveal the gravity 
undulations thought to be due to small-scale convection in this part of the south-central Pacific. In the 
profile pane, use the horizontal scroll bar to scroll through the along-track data. The Save Displayed 
Profile and Download Data buttons in the lower left may be used to save one or more cruises or just the 
portion of data visible in the profile window. Along-track data may be downloaded in MGD77 format and 
comma-separated CSV ASCII format, and profile images may be saved in JPEG and PNG formats. Import 
an MGD77/MGD77T file using the Import button in the upper right. 

 
Go to Table of Contents 

 
  

http://www.ngdc.noaa.gov/mgg/dat/geodas/docs/mgd2000.htm
http://www.ngdc.noaa.gov/mgg/dat/geodas/docs/mgd2000.htm
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5.3.2) Earthquake Focal Mechanism Solutions (CMT) 
 
Display and explore CMT focal mechanism final solutions from the Global CMT Project for more than 
43,000 events dating back to 1976. The database is updated about four times per year. When the portal 
is loaded, CMT solutions appear as blue symbols on the map. Zoom in to display the “beachball” 
solutions. 
 

 
Figure: When zoomed out, the moment tensor solution “beachball” images are displayed as blue symbols 
on the map. Zoom in to plot the beachballs. 
 

 
Figure: Screen shot of focal mechanism solutions for the Central America region. Using the cursor, one 
symbol was selected. It is circled in red near the centre of the map. The focal mechanism solution for that 
event is listed across the bottom of the GeoMapApp window and gives information on date, time, 
position, magnitude and nodal plane. The map can be saved under the File > Save map Window menu. 
 
Go to Table of Contents 

  

http://www.globalcmt.org/
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5.3.3) Earthquake Locations, Epicenter Depths and Magnitudes (ISC) 
 

See video tutorial on  
 
Display and filter earthquakes from the International Seismological Centre. 

 

 
 
Use the filters on the right for , ,  to change the 

displayed range of earthquake depth, magnitude and year. Click the  button each time a range is 
adjusted. Epicenters are color-coded as green = shallow, yellow = intermediate and red = deep. 

 
 
Save the map as an image using File > Save map Window menu. 
 
Go to Table of Contents 
  

http://www.youtube.com/watch?v=jo3i9eJITnw
http://www.isc.ac.uk/
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5.3.4) Location and Timing of Seafloor Earthquakes and Volcanic Eruptions 

 

See video tutorial on  
 
Create movie animations of earthquake activity during user-specified time windows for various 
NOAA/PMEL data sets.  
 
Three data sets are available: the Sound Surveillance System deep-water array (SOSUS, 17 years of 
data), East Pacific Rise (EPR, 6 years of data) and Mid-Atlantic Ridge (MAR, 4 years of data).  

 
 

Choose one of the three data sets by ticking the appropriate box ( ) then click  to load the 
selected data set. 
 
Once the portal has been loaded, the data set on display can be switched by selecting it ( )from the 

“areas” box in the right pane – see image below. Load the new data set by then clicking the  
button.  
 

 
 
The lower pane displays the earthquake activity and the animation parameters. 

 
 
The histogram shows the number of earthquakes (vertical axis) plotted against time (horizontal axis). 
Change the time range as follows: Move the cursor over one of the grey vertical lines. The cursor 

http://www.youtube.com/watch?v=xm4yRs2u7A8
http://www.pmel.noaa.gov/vents/acoustics/seismicity/seismicity.html
http://en.wikipedia.org/wiki/SOSUS
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becomes a double-headed arrow as shown in the image below. Click and drag the grey vertical lines left 
or right.  

      
 

Use the  button to reset the time period that is displayed in the histogram window. 
Date values are given in (year, day-of-year, time) format. An animation viewing speed of 5 

frames/second usually looks good.  
 

Start the animation with the  button. Save the animation as either an MPEG4 or 
QuickTime “.mov” file.   

 

 
Figure: (Left) Watch an earthquake swarm propagate over ten days in 1998 along the Juan de Fuca ridge 
axis at 45.75o N. (Right) View two earthquake swarms at the Wilkes Fracture Zone that occurred 
between 1999-2001. The epicentres are superimposed upon striking EPR axial topography mapped with 
multibeam echo-sounders. 
 
Go to Table of Contents 
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5.3.5) Multibeam Swath Bathymetry 
 

See video tutorial on  
 
Use a map of ship tracks to quickly identify and download multibeam swath data files. 
 
When this portal is loaded, ship tracks are displayed in the map window. Zoom and click on a track of 
interest. The chosen ship track turns white. The red part of the track shows the extent of the individual 
swath file for which the file name is listed in the lower left. Note that the red part of the track may be 
very short depending upon zoom factor and duration of particular swath files.  

 

 
Figure: The individual ping file is coloured red on the map and is listed in the lower left. All other ping files 
for that particular cruise are drawn in white on the map. 
 

Use the  button to download the selected multibeam swath file in its 
native format (all are compatible with MB-SYSTEM). 

 

The  button opens the MGDS web page for this cruise, if available. Save the map as an image 
using the File > Save map Window menu. 
 

http://www.youtube.com/watch?v=1pPRV5cUjt4
http://www.ldeo.columbia.edu/res/pi/MB-System/
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To help speed the loading time of this portal, a caching system has been implemented.  
 

 
The caching options, listed under the Cache Options tab, are turned on by default and when the portal is 
first loaded, the information is cached locally. Next time the portal is opened, it will load much quicker, 

typically about 50x faster. The cache can be deleted with the  button or 

disabled with the  box. 
 
 
 
Go to Table of Contents 
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5.3.6) Digital Seismic Reflection Profiles 
 

See video tutorial on  
 
Use this interface to view, compare, digitize, annotate, and extract digital Multi-Channel Seismic (MCS) 
and Single-Channel Seismic (SCS) reflection profiles from four sets of seismic data holdings. There are 
profiles from more than 120 cruises in the Lamont and UTIG Academic Seismic Portal collections; more 
than 35 USGS MCS cruises, 170 USGS SCS cruises and about 20 cruises for the Antarctic Seismic Data 
Library System. 
 
When the portal loads, geographical bounding boxes on the map show the extent of available seismic 
profiles.  
 
By default, profiles from the Lamont and UTIG MCS holdings are displayed on the map. 
 

      
 
To change the data holdings on display, select the appropriate radio button in the right pane, shown 
here: 
 

 
 
Zoom to your area of interest and click inside one of the boxes to display the seismic lines within that 
geographical bounding box. Each cruise has its own bounding box. In the map window click a line to 
select it, or use the drop-down menus at right to choose a cruise and a seismic line. The chosen line 
turns white.  
 

Select  to load the seismic profile in panel 1. The portion of the seismic profile that is 
displayed in the lower panel is shown as red on the map of seismic profile lines. To load a second line, 

http://www.youtube.com/watch?v=M2GWi9Ml93U
http://www.marine-geo.org/portals/seismic/
http://www.ig.utexas.edu/sdc/
http://cmgds.marine.usgs.gov/mcs/
http://cmgds.marine.usgs.gov/scs/
http://sdls.ogs.trieste.it/
http://sdls.ogs.trieste.it/
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click on another profile track in the map and select . Toggle between  

and  to display the profiles side-by-side or one above the other. 
 

Scroll through the seismic profile using the horizontal and vertical scroll bars (  ) next to the profiles. 
Note that the red portion of the seismic line moves with each horizontal scrolling action. Zoom in or out 

of the profile using the zoom buttons  in the profile pane. The profile axes show two-way travel 
time in seconds (vertical axis) and Common Mid-Point gather number (horizontal axis). 
 

Flip the profile laterally using the twin arrows button (  ).Switch to inverse video using the  
button. 
 

 
Figure: Comparing two Aleutian Trench MCS profiles that lie 800 km apart. Both are from Ewing cruise 
EW9409, with line 1232 in the left pane, line 1235 in the right pane. 
 

5.3.6.1) Save profile function 
 
Save the profile on display (“viewport” option) or the entire scanned profile (“full” option) using the left-

most diskette button next to flip-axis button ( ). The diskette button ( ) also allows the seismic 
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line navigation to be saved, and provides a link to download the SEG-Y file, if available. The options are 
shown here: 
 

 
 
 

5.3.6.2) MCS digitizing function 
 

Reflector horizons can be digitized, annotated and saved to a file using the   buttons directly 
above the profile display.  

 

 

Figure: Manually digitized horizon (blue line). The control buttons that trigger the Digitize ( ), Text 

annotation ( ) and Save Digitized Points ( ) functions are located in the toolbar above the profile. 
 

Activate the Digitize function by selecting . Click firmly with the mouse to digitize the points. Right-
click to delete the last digitized point or the most-recently digitized horizon. Digitized points can be 

https://seg.org/Publications/SEG-Technical-Standards
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moved with the cursor to refine their locations, as follows. To move a digitized point, click the Select 

Cursor/Pointer button  and click on the profile to activate it. The digitized points will be displayed as 
red squares.  

 
 
Click and drag any of the red squares to move them to new positions.  
 
To name the digitized horizon right-click on the profile to bring up the menu and click “Name Selected 
Horizon”: 

 
 
Then, type a name into the text box, like this: 

 
That name will be attached to the digitized points when saved. If the digitized horizon is not named, a 
default name of “Default” will be assigned. 
 

Save the digitized points with the right-most diskette button ( ) which is next to the profile zoom 

buttons, . The saved ASCII file contains four tab-separated columns giving longitude, latitude, 
Two-Way Travel Time, and CMP number, as shown below. 
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Note that on the segment-separator line of the saved file, eight values are listed to the right of the 
horizon name. The first of these values is the number of digitzed points. This and the remaining seven 
values are required in order for GeoMapApp to import the saved file at a later time. If those values are 
manually changed or deleted, the imported file will not be read correctly. 
 

Add text annotations to the seismic profile by selecting the text ( ) button, clicking twice in the profile 
window at the desired location, and typing the text in the text box that pops up, as displayed in this 
example: 
 

  Select   to accept the text. 
 

To digitize another horizon, click the Digitizer button   once again and repeat the steps above. The 
first digitized profile will remain unchanged. In this example, two reflectors have been digitized. 
 

  



    User Guide for GeoMapApp v3.7.1 

Page 43 of 164 

Saving the digitized points will save all points for all digitized horizons to a single file. In the saved file, 
the “>” symbol separates the digitized horizons. Toggle between the digitized profiles by clicking on a 
profile to activate it. Whenever a digitized profile has been activated, the points can be moved as 
described above. 
 
In the right-click menu, “Delete Last Horizon” and “Delete Last Pick” operate on the last profile to be 
digitized (i.e. on the most-recently-digitized profile) regardless of which profile is active. 

 
 

To import previously-digitized points for this particular seismic line, click the Import folder icon  
and select the appropriate saved digitized file. GeoMapApp will automatically zoom in and plot the 
digitized horizon. 
 

Exit the digitizer mode by clicking the adjacent arrow cursor button . 

 
Go to Table of Contents 
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5.3.7) Analog Seismic Reflection Profiles 
 
As part of a data rescue effort, about 260 scanned Single-Channel Seismic (SCS) reflection profiles can be 
viewed, digitized, annotated and extracted using this interface. The profiles were collected on cruises of 
Lamont-Doherty’s research vessels Robert D. Conrad (for the years 1963-1978), Eltanin (1965-1972) and 
Vema (1960-1980).  
 
There are two ways to view a profile. Either, click on a track line in the map window. The selected cruise 
track turns white and its name is highlighted in the cruise list at right. Or, click on a cruise name from the 
list at right. Note that all of the SCS cruises remain in the list when zooming or panning.  
 

Once a track has been selected, click  to load the SCS profile in the 
lower pane. The vertical axis gives two-way travel time in seconds. The horizontal axis is distance along 
profile. The length of profile shown in the lower pane is displayed in red on the track map.  
 

 
Figure: Reflectors in the SCS profile for 1967 western Pacific Vema cruise V2407, around (157.2E, 1S). The 
thin red line at the top of the reflectors represents PDR depth. 
 
The thin red line that appears at the top of the reflection profile – see example image below – is the 
seafloor depth taken from the precision depth recorder (PDR) data. This line delineating PDR seafloor 

depth can be turned off and on by clicking the toolbar PDR button:  is on, and  is off. 

http://www.ldeo.columbia.edu/
http://www.ldeo.columbia.edu/res/fac/oma/history/conrad.html
http://www.ldeo.columbia.edu/res/fac/oma/history/eltanin.html
http://www.ldeo.columbia.edu/res/fac/oma/history/vema.html
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5.3.7.1) SCS save profile function 
 

Save the profile on display – or the entire scanned profile – using the right-most diskette button ( ) 

located between the profile zoom buttons,  and the cursor button, .  
 

5.3.7.2) SCS digitizing function 
 

Reflector horizons can be digitized, annotated and saved to a file using the  and  buttons to 
the left of the SCS profile display.  
 

Activate the Digitize function by selecting . Click firmly with the mouse to digitize the points. Right-
click to delete the last digitized point or the most-recently digitized horizon. Digitized points can be 
moved with the cursor to refine their locations, as follows. To move a digitized point, click the Select 

Cursor/Pointer button  and click on the profile to activate it. The digitized points will be displayed as 
red squares.  
 

 
 
Click and drag any of the red squares to move them to new positions.  
 
To name the digitized horizon right-click on the profile to bring up the menu and click “Name Selected 
Horizon”: 

 
 



    User Guide for GeoMapApp v3.7.1 

Page 46 of 164 

Then, type a name into the text box, like this: 

 
That name will be attached to the digitized points when saved. It is also listed in the area to the left of 
the seismic section, as shown ringed in red here: 

 
 
If the digitized horizon is not named, a default name of “Default” will be assigned. 
 

Save the digitized points with the left-most diskette button ( ) which is next to the PDR toggle button 

. The saved ASCII file contains ten tab-separated columns giving UNIX time, longitude, latitude, Two-
Way Travel Time of the digitized point, distance from start, PDR depth, Seafloor age if available, and 
digitized point depth, sediment thickness and backtrack depth, as shown below. 
 

 
 
Note that, if named, the name of digitized horizons will be listed on the segment-separator line. To the 
right of the horizon name is given the number of digitized points.  
 

Annotate with the text ( ) button by clicking twice in the profile window and typing text in the text 
box that pops up.  

 
 
Here is an example of a digitized, annotated reflector: 
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To digitize another horizon, click the Digitizer button   once again and repeat the digitization steps 
outlined above. The first digitized horizon will remain unchanged, and the additional digitized horizons 
will be listed on the left.  
 

 
 
Saving the digitized points will save all points for all digitized horizons. In the saved file, the “>” symbol 
separates the digitized horizons. Toggle between the digitized horizons by clicking on a horizon to 
activate it. Whenever a digitized horizon has been activated, the points can be moved as described 
above. 
 
In the right-click menu, “Delete Last Horizon” and “Delete Last Pick” operate on the last horizon to be 
digitized (i.e. on the most-recently-digitized horizon) regardless of which horizon is active. 

 
 
 
To import previously-digitized points for this particular seismic line, click the “Load Previously Digitized 
Products” button located on the right beneath the list of cruises and select the appropriate saved 
digitized file: 

 
GeoMapApp will plot the imported digitized horizons as a green lines with the imported digitized points 
as red squares, like this: 
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Note that the display may not automatically zoom in to the exact portion of the seismic profile. The 
profile window may need to be scrolled and/or zoomed to find the imported digitized points. 
 
 

Exit the digitizer mode by clicking the adjacent arrow cursor button . 
 
 
 
 

Summary of SCS toolbar buttons controlling SCS profile options: . From 

left to right: Save digitized points ; Turn off/on PDR seafloor depth ; Zoom in ; Zoom out ; 

Save profile image ; Pointer/Cursor ; Digitizer ; Text annotator .  
 
 
 
 
 
 

5.3.7.3) Note on zooming in the SCS profile window  
 

If the zoom in ( ) or zoom out ( ) button is active, it can be deactivated only by clicking the same 

button again. The background color of the button indicates zoom active  (darker color ) or inactive 

(lighter color ). 

 
Go to Table of Contents 
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5.3.8) Ocean Floor Drilling 
 

See video tutorials on  

 Introduction 

 Data Types 

 Range Charts 

 Age-Depth Models 

 Physical-Chemical Data and Core Photos 

 Geological Timescale, Keeping Track of Age and Depth 
 
The Ocean Drilling portal offers a wealth of data for drill holes of the Deep Sea Drilling Project (DSDP 
Legs 1-96), the Ocean Drilling Program (ODP Legs 100-210) and the Integrated Ocean Drilling Program 
(IODP Legs 301-312).  
 
When the portal is selected, the location of all drill holes in those three programs is plotted in the map 
window. A new window also appears. It displays a scrollable list all of the holes in the current map view.  

 
To select a hole, either click a hole in the map window (turns red), or click a row in the table (turns blue). 
Multiple holes can be selected by using shift-click in the table. 
  

http://www.youtube.com/watch?v=8oLJqEqnRgA
http://www.youtube.com/watch?v=3yx-0l9llkA
http://www.youtube.com/watch?v=4-DmhbpeAkM
http://www.youtube.com/watch?v=i0poDi-7-_0
http://www.youtube.com/watch?v=Qhpgy327uis
http://www.youtube.com/watch?v=RFlUcUV1S28
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Figure: DSDP hole 24-238 in the central Indian Ocean has been selected. In the map window, the symbol 
showing its location has turned red, and, in the record table window, the row is highlighted in blue. 
 
Scroll to the right in the table to see columns of common fauna found in cores (nannofossils, 
foraminifera, diatoms, and so on). In those columns, the “true”/“false” labels indicate the existence of a 
range chart for that particular fauna in that particular core. To display all holes with range charts of, say, 

diatoms, click twice on the diatom column header  to sort those records and highlight all 
holes with diatom range charts. Their locations turn red in the map window. 
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Figure: Holes with diatom range charts. 
 
Note that, at times, the drill hole location symbols may be hidden under the symbols of other data sets 

or under images of other base maps. Click the  button make them reappear.  
 

Click  to exit this DSDP-ODP-IODP portal. 
 

 
5.3.8.1) Additional functionality within the Ocean Floor Drilling interface 
 

Enhanced features are triggered by these icons  in the DSDP-ODP-IODP tool 
bar. 
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5.3.8.2) Data types folder  
 

See video tutorial on  
 

The folder icon  opens a new window, as shown here.  
 

 
 
In the left pane is a list of various data types. In the right pane are control parameters, including a slider 
bar to specify age range. 
 

Choose a data type from the drop-down menus and press  to illuminate in the map 
window all holes reporting that data type within the specified age range. In the example shown at right, 
holes with mica in the 0-2 Ma range have been selected. 
 
The name of the selected data type is given in the upper right corner of the folder window 

 

Click and drag the slider bar  to change the age range. This allows relative abundances to be 
visualized through time. The highlighted holes in the map window change with each chosen age range: 
only those containing the selected data type in the specified age range are displayed. Change the time 

range increment by clicking the  button. 

http://www.youtube.com/watch?v=3yx-0l9llkA
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Holes that do not contain that data type in the specified age range can be turned off and on using the 

 icon. 
 

The color icon  uses a color table to display the relative percentage of the data type for the chosen 
age range. Red indicates high values, blue indicates low values. 
 
More than one data type can be loaded although only one at a time can be visualized. The loaded data 
types are listed in the drop-down menu in the upper right. Switch between loaded data types by 

selecting them from the drop-down menu. Click the discard icon  to remove the selected data type 
from this list.  

 

 
Figure: Colored hole symbols showing the relative abundance of carbonate in the 6-8 Ma time range. 
 
Currently, quantitative measurements are available in GeoMapApp for DSDP legs 1-96.  
 
Go to Table of Contents 
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5.3.8.3) Faunal Range Charts  
 

See video tutorial on  
 

The range chart icon  opens a window with faunal range information.  

 

 
 

Using the drop-down menu  choose the type of fauna and flora to 
display in the range chart, if reported for the selected hole. 

 

http://www.youtube.com/watch?v=4-DmhbpeAkM
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The graphical part of the window contains four areas.  

 
Figure: Range chart structure. On the left, shaded grey boxes show the presence of cores at their 
respective depths (in meters) below the sea floor. The next column will activate a function that brings up 
core descriptions. It should be active in a future release of GeoMapApp. In the middle are the epoch and 
stage ages with name. Faunal ranges are shown on the right, as thin grey vertical lines.  
 

In the faunal range, black dots ( ) represent the core sample depths.  
 
Click a dot to display information about a species, in the lower part of the window.  

 
 
In detail, the following information is presented. 
 

 The species name ( ). 

 Location of sample within the core ( ). Here, 16-3-25 cm 
refers to the core number (16), section (3), and depth in section (25 cm). Followed by reporting 
author (A.R. Edwards), report volume (21), and page number (650). 
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 Depth information ( ) lists depth in meters below sea floor 
(305 mbsf), age at that depth in millions of years before present (25.968 Ma). BTD (3248 mbss) 
gives the back-track depth of the sea floor of that age expressed in meters below the paleo sea 
surface (mbss). It is calculated by removing the thermal subsidence since that time and by 
unloading the lithosphere by the weight of the sediments that have accumulated since that 
time. 

 

 Further information contained in external databases about this species is given under the three 

hyperlinks ( ). 

 
The selected species is highlighted in light blue in the range chart. As the cursor is moved in the window, 
a horizontal red line tracks the cursor giving updated depth/age information.  
 

 
 
The four buttons  across the top of the range chart window 

provide links to more information. The Janus button  links to the JANUS database at Texas 
A&M University to display the Hole/Core summary results. 

        
 

The CHRONOS ARC button  goes to the CHRONOS portal and displays age model 
information for the selected hole. 

. 
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The Logs button  is currently inactive. 
 

The Initial Report button  displays the table of contents and links to chapters of the 
report for the leg during which the hole was drilled.  

 
   
 
Go to Table of Contents 
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5.3.8.4) Age-Depth Models  
 

See video tutorial on  
 

When a hole has been selected, the age-depth model button  opens a graph in a new window.  
 

 
 
The horizontal axis gives the sediment age, and depth is given in meters below seafloor (mbsf) on the 
vertical axis. Orange rectangles mark the epoch/stage boundaries. Fossil ranges are shown as blue and 
green lines. The extent of the blue and green lines defines the first and last occurrence. 
 
As the cursor moves down the graph, age-depth control points appear as red circles on the depth-age 

line. These age-depth values can be saved in a text file using the save button . 
 
To change the age range displayed on the horizontal axis move the cursor to hover over either the left 
or right vertical axis line. When the cursor symbol changes to a double-headed arrow, drag the cursor 

sideways to change the range. The graph scaling can be reset by clicking the normalizing button . 
 
The fossil ranges, as defined by their first and last occurrence, are turned off and on with the 

 button. The  button opens a web page giving CHRONOS portal 
Line-of-Correlation information. 
 

http://www.youtube.com/watch?v=i0poDi-7-_0
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Users can modify the age-depth model by clicking the  icon. When active, click on an age-depth 
control point and drag it with the mouse to change its age and depth value. To create a new control 
point, click at the new location in the graph window. The age-depth curve will instantly adjust to include 
this new control point. The new set of age-depth values can be saved in a text file with the save button 

. Clear the new points with the graph reset button .  
 
Previously-stored age-depth models created in earlier GeoMapApp sessions can be accessed using the 

drop-down menu at the top of the window, . The default age-depth model can be 
reloaded by selecting “Default” from the menu. The current age-depth model can also be saved under 
this menu. The saved file is stored in the user’s GeoMapApp home directory, or can be stored elsewhere 
using the file navigation buttons. 

 

The text display ( ) at the base of the graph 
lists six pieces of information about the control points and age-depth model – three values for the 
control points, and three values for the age-depth model. From left to right these values are: (a) The 
number of the control point nearest the cursor; (b) its depth in meters below seafloor (mbsf); (c) its 
assigned age (Ma). These are followed by three values for the age-depth model at the location of the 
cursor: (d) the depth in meters below seafloor (mbsf) of the cursor position; (e) the corresponding 
sediment age from the age-depth model (Ma); and, (f) the calculated back-tracked depth (BTD) in 
meters below the paleo sea surface (mbss).  

 
Go to Table of Contents 
 
 
 

5.3.8.5) Physical-Chemical Measurements Graphs and Core photos  
 

See video tutorial on  
 
For each drill core, a range of physical and chemical measurements were made on the recovered core 
and, in many cases, photos of the cores were taken. These can be viewed using the graphing function 

 which opens a window like this: 
 

http://www.youtube.com/watch?v=Qhpgy327uis
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Measured categories are listed in the left-most drop-down menu. Shown in this example is Carbon. 
Types of measurements within that category are listed in the right-most drop-down menu. Here, 
“percent total carbon” has been selected and graphed.  
 

 
 
The figure below describes the structure of the window. 
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To access the core photos, click the  button in the lower left corner of the graph 
window. A blue column appears in the graph window between the epoch/stage names and the depth 
axis.  
 

 
 
If hand-drawn visual core descriptions are available, another column of squares appears, one for each 
core section to display the description. Click one of the small black squares to bring up the core photo in 
a browser window. 
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The ASCII data table from which the graph is drawn can be viewed using the  
button which opens a text editor. 
 

 
 

The tabular data values are saved to a file using the  button. 
 
Where a measurement category has multiple data types, the graph for each type can be viewed side-by-

side using the  button. From the pop-up menus choose the category and data type 
to plot. A new graph will be plotted next to the first one as shown below. Individual graphs can be 
discarded by clicking the small  in the upper right corner of each additional graph.  
 

 
Figure: Graphs of total carbon, organic carbon and CaCO3 plotted side-by-side. The new graphs can be 
deleted by clicking  (upper right corner).  
 

The graphing window is discarded with the  button.  
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Go to Table of Contents  



    User Guide for GeoMapApp v3.7.1 

Page 64 of 164 

5.3.8.6) Geological Timescale 
 

See video tutorial on  
 

The Geological Timescale icon  opens a window displaying Period, Epoch and Stage boundaries, the 
geomagnetic polarities time scale and faunal zonal boundaries for foraminifera and calcareous 
nannofossils, and the delta 18O curve of Zachos et al., 2001.  

 
 
A horizontal red line tracks up and down in this window corresponding to the age of the sediment 
derived from the age-depth model. This allows the range chart and physical/chemical measurement for 
the selected hole to be directly correlated with the standard chronology and internationally-recognized 

epoch/stage boundaries and magnetic reversal time scale. Use  in the top-left to zoom on the 
timescale. 
 

5.3.8.7) Zooming on graphs 
 
When viewing the graphs (range charts, age-depth graph, and physical-chemical measurements graph) 
zoom functionality is available: To zoom in, hold down the control key and click the cursor within the 
graph. To zoom out, hold down the control and shift keys and click the cursor within the graph.  
 

5.3.8.8) Keeping track of depth in the core section 
 
The vertical position of the cursor creates a horizontal red line that moves in synchronization in all the 
windows to indicate the same depth below the seafloor. This can assist in correlation between the 
various data types being graphed.  Even if graphs have been zoomed, the red line still shows the 
corresponding depth in each graph. 

 
Go to Table of Contents 
  

http://www.youtube.com/watch?v=RFlUcUV1S28
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5.3.9) PetDB (Composition of the Oceanic Volcanic Crust)  
 
Explore geochemical analyses and sample locations for samples in the PetDB petrological database. The 
data content is updated about four times each year; the date of the most recent update is given in the 
upper right.  
 

 
 
PetDB sample locations are plotted as squares on the map. Samples and data are displayed on different 
tabs beneath the map. Filter parameters and color/selection options are available on the right. 
 

5.3.9.1) Overview 
 
Click a symbol on the map (it turns red); the data record for this symbol is highlighted in the lower table. 

When the Stations tab is active  the columns in the table list 
the following information: 
 

 - Number of samples associated with the chosen station 

- Type of material analyzed. Codes are listed in right panel ( ) 

 - Data type codes are listed in right panel ( ) 

 - Type of rock analyzed. Codes are listed in right panel ( ) 

 - Coordinates of sample location. 
 
 

http://www.earthchem.org/petdb
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The Analyses tab  lists the individual geochemical analyses for 
each sample associated with the chosen station. Click the column heading to sort the values.  

 
 

The Compiled Chem tab  lists the compiled geochemistry 
analyses for all samples associated with the chosen station. Click the column heading to sort the values.  

 
 
 

5.3.9.2) Filtering the PetDB samples 
 
By default, all samples are displayed. The right-hand panel provides the capability to filter the samples 

by type of material, type of data, and type of rock. Click the tick box of an item in the list to select ( ) or 

de-select ( ) it. Click  to de-select all items; click  to select all items.  
 
In the following example, basaltic glasses with REE and volatiles analyses have been manually selected. 
Only those samples that satisfy these parameters are plotted on the map. 
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The PetDB web page for the selected samples can be accessed by clicking this button beneath the filter 

parameters:  
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5.3.9.3) Color, Graph and Lasso data 
 

The  button opens a pop-up window in which the column to color is chosen 
from the list.  
 

 

Select an item (in the example shown above we chose Nd). Click  to open the color palette 
histogram. 

   
 
Slide the grey lines in the color histogram to the left or right to change the symbol color range displayed 
in the map window. 
 

To plot any two numerical columns, click  and select the x-axis and y-axis 
variables from the drop-down lists. If symbols have been colored (on any column) that coloration is 
preserved in the graph. 
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Figure: Compiled chemistry for sample 208NMNH113716: Graph shows Ce plotted against La, with 
coloring on Nd. 
 
In the Graph window, the axes can be re-scaled as follows: Move the cursor onto a blue line near the 
graph edge. When the cursor turns into a double-headed arrow, drag the cursor left or right. The axis 
will rescale instantly. 
 

The Lasso Tool is found in both the right-hand panel ( ) and in the graph window ( ) 
and is used to capture specific samples of interest. Click to activate then use the cursor and free-hand 
drawing to draw a line that captures points of interest. The Lassoing can be done in either the map 
window or in the Graph window, as shown here.  
 

 
 
When the cursor is released, all of the selected samples are highlighted in the table in blue, and the 
selected points are ringed in red in both the map window and the Graph window. 

PetDB data can be saved using the options listed in the right pane under the  button. 
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See this section for more information on coloring and graphing data points. 
 
Go to Table of Contents 
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5.3.10) Seafloor Magnetic Anomaly Identifiers 
 

See video tutorial on  
 
Explore isochrons of seafloor magnetic anomalies using Mueller et al’s compilation.  
 
When the portal interface has loaded, zoom and select an isochron of interest. Two things happen: The 
selected isochron turns white in the map window, and the isochron name and age are displayed in the 
lower left. 

 

 
Figure: Isochrons in the north Atlantic. Anomaly 18 has been selected. Its age is listed in the lower left. 

Click on the web page link  to open an information page describing the data set. The 

isochrons can be turned off and on by ticking/unticking . 
 
Education suggestion: The magnetic isochron data can be combined with the profile-distance tool to 
determine distance and age from a spreading ridge, and thus the spreading rate. See this education 
module for suggestions. 
 
Data set reference: Müller, R.D., Roest, W.R., Royer, J.-Y., Gahagan, L.M. and Sclater, J.G., 1997, Digital 
isochrons of the world's ocean floor, Journal of Geophysical Research, 102, 3211-3214.  
 
Go to Table of Contents 
  

http://www.youtube.com/watch?v=RvTdhn8pK9w
http://gdcinfo.agg.nrcan.gc.ca/app/agegrid_e.html
http://serc.carleton.edu/geomapapp/activities/seafloor_spreading.html
http://serc.carleton.edu/geomapapp/activities/seafloor_spreading.html
http://www.agu.org/pubs/crossref/1997/96JB01781.shtml
http://www.agu.org/pubs/crossref/1997/96JB01781.shtml
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5.3.11) Seafloor Photographic Transects 
 
This portal provides still photographs from the dives of deep sea vehicles Alvin and Jason operated by 
Woods Hole’s National Deep Submergence Facility. The track of each dive is displayed in the 
GeoMapApp map window and separate windows are used to view the dive photos. 
 
The menu list is grouped by geographical area. After choosing one dive from the menu, a Shapefile 
Manager window appears. The right pane lists the available dives for that area.  

 
 

Click to highlight one of the dive records then click the light bulb  to list all photos available for that 
dive (change the column width by dragging the column borders sideways): 

 

Click the light bulb  to open a photo display window. Alvin carries two cameras so the light bulb can 
be clicked twice to bring up two photo viewing windows. Jason has four cameras and four clicks 
produces four viewing photo windows.  
 

For each photo display window, use the drop-down menu  at the top to select the camera 

and use the arrow buttons  to scroll through the available photographs. With each click the 
photos displayed in all windows are changed. To jump to a particular time, click the corresponding row 
in the right pane of the Shapefile Manager. 
 

The  zoom function will zoom the map to the area of the selected dive. The  button opens a web 
page containing more information about the parent cruise. 
 

http://www.whoi.edu/main/ndsf
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Figure: Example of a dive seafloor photo in this case collected with the WHOI NDSF Jason II ROV during 
cruise KN180-01 to the Mid-Atlantic Ridge TAG hydrothermal site. 
 
Additional dives can be loaded. They will appear as layers in the left side of the Shapefile Manager and 
only photos from the selected dive will be displayed. The shapefile can be toggled on and off using the 

visibility buttons  . Discard the shapefile using . 
 
 
For the five Alvin dives listed for the New England Canyons, the photo locations are presented in the 
same interface used for tabular data, as shown in the example below.  
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Click any row in the table or any dot on the map to generate a thumbnail image of the photograph at 

that locality and use the arrow buttons  to scroll through the available photographs. 

  
 
Click a hyperlink in the Links column in the table to display the full-resolution image in a web browser. 
 

 
 
Go to Table of Contents 
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5.3.12) Search Expedition Data 
 

See video tutorial on  
 
This portal allows searching of data associated with more than 2,200 field programs and data 
compilations in the MGDS database. 
 

 
 
Select a cruise track in the map window by clicking on an individual track line with the cursor. The track 
will turn white and the cruise record is highlighted in the record table beneath the map. Alternatively, 
select a row from the table – the record is highlighted and the cruise track will turn white in the map 
window. 
 
Only records for cruise tracks falling within the displayed map area are listed in the table. Columns can 
be sorted by clicking the column header. The width of columns is changed by dragging the column 
header boundary left or right. 
 

 
 
In addition to basic information about the field programs, the columns in the right side of the table, as 
displayed in the image above, report the status of cruise-related data. The columns are coded as follows:  
 

 “online”: Data files are available on-line by clicking the URL link in the  column. 

 “offline”: Data files are currently unavailable. 

 blank cell ( ): No data collected. 

http://www.youtube.com/watch?v=SGHOE7lDaFk
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BOOLEAN-based searching for data is done using the controls in the right pane. Comma-separated 
search terms are typed into the text box.  
 
In the example below, only those cruises collecting Multibeam and Gravity data during year 2001 will be 

displayed when the  button is clicked. 
 

 
 

Selecting instead the  radio button would return all cruises that collected Multibeam or collected 
Gravity data or operated during year 2001. 
 
Go to Table of Contents 
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5.3.13) GPS Velocity Vectors 
 
This portal displays geodetic horizontal plate motion velocity vectors using either the built-in EarthScope 
Consortium (UNAVCO) geodetic solutions or user-imported geodetic data.  

 

 
 
The built-in data sets are updated at intervals. They are listed in the Select Velocity Data drop-down 
menu on the right:  

 
The built-in UNAVCO EarthScope PBO solutions are in both IGS08 and NAM08 reference frames, and the 
solutions from both Central Washington University and New Mexico Tech are in NAM08.  



    User Guide for GeoMapApp v3.7.1 

Page 78 of 164 

 
After selecting a data set, the vector display parameters can be specified as shown below.  
 

 
 

 Vector length scale: Specify the length scale for the vector arrows. Default is 1.0 millimeter = 
1mm/year of plate motion When the vectors are displayed on the map, the Legend shows the 
length of a vector representing a horizontal velocity of 10mm/year, like this: 

 
 

 Show error ellipses: Tick the Show error ellipses box to draw velocity solution error ellipses at 
the head of each arrow. Default is no ellipses. If error ellipses are chosen, the confidence ellipse 
value can be specified by changing the Confidence level number. Default is 0.95 for 95%. 

 

 Number of velocity solutions displayed: Decimate the number of vectors drawn on the map by 
choosing the level of decimation from the drop-down menu: 

 
The default is to display all vectors. For areas with dense station coverage, such as southern 
California, a decimation level that shows one in five or one in ten may yield a clearer map 
display. Every time the decimation is changed, the Submit button must be clicked. 
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Once the Submit button is clicked, the velocity vectors are drawn on the map and the solutions are 
displayed in the table beneath the map. On the map, the stations are shown as small block dots and the 

velocity vectors are drawn as red arrows.  
 
The number of solutions displayed is given in the Points Displayed box, like this: 

 
 
Click on a black dot to highlight that station record. The arrow and dot will change from red to yellow on 
the map and, in the table beneath the map, the chosen solution will be highlighted in blue. Conversely, 
click one or more records in the table to highlight the corresponding vectors on the map. 
 

 
Figure: An example of decimated (one-in-twenty) velocity vectors in southern California. One selected 
vector is highlighted in yellow on the map and in blue in the table beneath the map. 
 
Velocity Vector data can also be imported. The imported file needs to be in tab-separated ASCII format 
and must at a minimum contain the following columns with the specified column header (header label is 
not case sensitive): 
 

 Latitude column (in decimal degrees). Header label "lat" 

 Longitude column (in decimal degrees). Header label "lon" 

 North velocity column. Header label "dn/dt", "north velocity" or "vel_n" 

 East velocity column. Header label "de/dt", "east velocity" or "vel_e" 

 North velocity standard deviation column. Header label "snd", "n. vel std dev" or "sig_n" 

 East velocity standard deviation column. Header label "sed", "e. vel std dev" or "sig_e" 

 North/East velocity correlation coefficient column. Header label "rne" or "rho_en". 
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This import format is similar to the GMT psvelo minimum format. Here is an example of a file that is 
successfully imported in GeoMapApp. It contains the minimum columns listed above along with 
additional columns for the vertical velocity components. 
 

 
 
When imported, the solutions are plotted on the map and are tabulated beneath the map. These 
stations lie in eastern California, close to the California/Nevada state border (load the state boundaries 
from Overlays > Local Administrative Boundaries > United States > US State Boundaries): 
 

  
 
 
Go to Table of Contents 
 

 
 
  

https://www.soest.hawaii.edu/gmt/gmt/html/man/psvelo.html
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5.3.14) Waypoints and Survey Planner 
 
This portal allows generation and manipulation of waypoints and survey lines and provides basic 
information including distance between waypoints, track length, along-track distance, sailing time, and 
cumulative distance. The portal is also useful for sampling any loaded grid at user-specified points. 
 

 
Figure: In this example, a series of waypoints has been generated in the Indian Ocean. The digitized 
waypoints are displayed beneath the map. Use the radio buttons on the right to draw the elevation 
profile along the digitized track segments. 
 
The Waypoints and Survey Planner Portal operates in one of two modes: Waypoints mode or Survey 
Line mode. Choose the mode using the radio buttons in the right pane: 
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5.3.14.1) Waypoints mode 
 
Interactive waypoints may either be (a) generated within the portal or (b) imported from a file.  
 

5.3.14.1a) Generate Waypoints 
 
To generate waypoints, click the Generate Waypoints button in the right pane. 
 

 
 

Click the green Start Digitizing button  and click on the map to 
generate waypoints. A square will be displayed at each waypoint. By default, a great circle track is drawn 
between pairs of waypoints. Switch between great circle and straight line segments in the right pane. 
 
To stop digitizing either double-click the last point or click the red Stop Digitizing button. 
 
The digitized points are displayed in the table beneath the map.  

 
 
Use the Great Circle/Straight Line buttons to switch between great or small circle tracks between points. 
 
As an option, enter a ship speed to calculate the travel time between points. This will fill in the Duration 
column in the table: 

 
 
In the lower right, use the Draw Profile button to generate an interpolated elevation profile between 
the points from the GMRT global elevation synthesis.  

 
The elevation values are extracted from the GMRT elevation model by interpolating 100 intermediate 
points between each pair of digitized points so that a smooth profile is generated. The interpolated 

https://www.gmrt.org/
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points are displayed when the  button is clicked. The profile can be saved as an 

image using the Save button in the lower right. Note that the Draw Profile option  must 
be active in order to save the profile as an image. 
 

Clicking the  button shows that the Elevation column in the table has been filled in: 

 
 
The digitized points are interactive - drag the points on the map or manually edit the Latitude or 
Longitude values in the table to move points (double-click the table cell to edit a value). In the example 
below, one of the points is dragged to the SSW. The table and profile are updated instantly to reflect the 
new positions. 
 

       
The ability to move the points either by dragging them on the map or manually editing the Lat/Lon 
values in the table allows the positions to be defined precisely. 
 
Save the table or profile using the Save button in the lower right. Any interpolated points will also be 
written to the saved file when the save table option is chosen. Example: 
 

  
 
There are two ways to continue adding waypoints to the ones that have already been generated.  
To add new points to the end of an existing digitized segment, click the Append to Segment button: 

. Doing so will re-activate the digitizing function. 
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To add new points within an existing digitized segment, first activate one of the digitized points: Do this 
either by clicking on the point on the map or selecting a row from the table beneath the map. Once an 
existing point has been activated, it will turn red and the Insert Before Selected Point button is now 

available in the right pane: . Click that button and a message 
pops up to notify the user that the digitized points will temporarily disappear from the table whilst the 
new points are added. Click on the map to add new intermediate points. To finish adding new 
intermediate points, either double-click the point just added or click the red Stop Digitizing button. 
 
To delete specific waypoints click on the point on the map or select a row from the table beneath the 

map and then click the Delete Points button in the lower right:  
 
Delete the entire set of waypoints with the Delete Segment button 
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5.3.14.1b) Import Waypoints 
 
A file containing waypoints may be imported and manipulated – points moved, profiled, etc - just as if 
the waypoints had been generated in the portal as described above.  
 
The imported file needs to be an ASCII file with either comma-, tab-, or pipe-separated columns and 
must contain at least a latitude column and a longitude column. Additional columns are allowed. The 
first row must be a header using the words "Lat", "Latitude", "Lon" or "Longitude" to define those 
latitude and longitude column labels. Any additional columns must also have a header label, too. 
 
Each waypoint is defined by a longitude and latitude value in decimal degrees, one waypoint per row. 
Use negative values for south and west coordinate values.  
 
Here is an example of a tab-separated file containing waypoints and some additional columns: 
 

 
 
Imported waypoints are interactive - drag the points on the map or manually edit Lat/Lon values 
in the table by double-clicking the table cell. See also the information above.  
 
 

5.3.14.1c) Sampling any grid using waypoints 
 
By default, the digitizing function in the Waypoints and Survey Planner table will sample the GMRT 
global elevation model at the locations of the waypoints. But, if any other grid is loaded in the base map 
window, the digitized points will sample that grid instead. This functionality, in fact, applies to any 
loaded built-in grid or imported grid. This allows the GeoMapApp waypoints portal to provide a grid 
sampling capability that is similar to the 2-D grid sampling function offered by the GMT grdtrack 
program. In addition, the grid sampling works on both imported and generated waypoints. 
 
Example: In the screenshot below, the global Geoid Heights data from Sandwell and Smith (v9.2) has 
been loaded from the DataLayers menu. In the table beneath the map, the Elevation column that was 
previously displayed is now replaced with the geoid height values.  
 

https://www.gmrt.org/
https://www.soest.hawaii.edu/gmt/gmt/html/man/grdtrack.html
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And, here’s an example of both the table and the extracted profile for a set of waypoints that is used to 
sample and profile a gravity free-air anomaly (FAA) grid. 
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5.3.14.2) Survey Line mode 
 
Interactive survey lines may either be (a) generated within the portal or (b) imported from a file.  
 

5.3.14.2a) Generate Survey Lines 
 
To generate survey lines, click the Generate Survey Lines button in the right pane. 
 

 
 
A survey line is specified in one of two ways: either manually by giving start/stop coordinates or by using 
the cursor/mouse to draw a line on the map.  
 

Use start/stop coordinates  Ensure that Manually has been selected.  Then, 
type the start/stop coordinates in decimal degrees into the text boxes using negative values for 
south/west coordinates and hit Submit (you may have to scroll to see the Submit button). This example 
defines a track off the NW coast of Spain: 

 
Once the Submit button has been clicked, a red track line is displayed on the map. A small yellow arrow 
on the track indicates the direction of travel from the start point to the stop point. 
 

 
 

Use cursor to draw survey line  Ensure that Use Mouse has been selected   
Then, click and drag on the map to draw a line and hit Submit (you may have to scroll to see the Submit 
button). The coordinates are automatically filled in and a red track line is displayed on the map. A small 
yellow arrow on the track indicates the direction of travel from the start point to the stop point. 
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By default, the track between the two points is a great circle route. Use the Great Circle/Straight Line 
buttons to switch between great or small circle tracks between points. 
 
The lines are interactive - drag the end points on the map to change their positions or manually edit the 
Lat/Lon values by double-clicking Lat/Lon cells in the table beneath the map.  
 
Additional parallel survey lines may be generated automatically as follows. In the right pane boxes enter 
the total number of survey lines and their desired line spacing (km), and use the arrow buttons to define 
the perpendicular trend of the additional lines relative to the first line. Hit Submit. The first track line is 
shown in red.  
 
In the following example, three additional lines (making a total of 4), each 50km apart, trending to the 
Southeast have been defined. When the Submit button is clicked, the additional lines will be drawn on 
the map and small yellow arrows on the tracks indicate the direction of travel. 

             
 
The survey line coordinates are displayed in the table beneath the map: 
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Enter a ship speed (e.g. 10 knots) to calculate distances and duration.  

 
 
To fill in the start/end elevations, it is necessary to load the underlying GMRT global elevation model. 

For that, click the grid load shortcut in the toolbar:  
 
Once the GMRT base map grid has loaded, the start/end elevation values are displayed in the table 
beneath the map: 

 
 
If any other grid is loaded, the values in the elevation columns will instead be filled with the Z values 
from that loaded grid. In the example below, a gravity free-air anomaly grid has been loaded 
(DataLayers > Geophysics > Gravity Anomalies and Geoid Heights). The gravity grid is displayed in the 
map and the free-air anomaly values are listed in the table, like this (note, though, that the column 
header labels in the table are still called Elevation): 
 

 
 

 
 
 
As with the waypoints, the lines on the map may be edited either by dragging the start/end points on 
the map or by double-clicking a lat/lon cell in the table and manually changing the values. The changes 
are instantly reflected in the map display and in the table values beneath the map. In the example 
below, the two southerly lines have been moved: 

https://www.gmrt.org/
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Use the Add Row to Table button or Delete Row(s) button in the lower right to add or delete rows. 
When adding rows, additional survey lines in any orientation may be generated by manually adding a 
row to the table: After clicking the Add Row to Table button in the lower right, double-click the Lat/Lon 
cells to enter the coordinates, then hit enter. 
 

 
 
Save the table as a comma-separated ASCII file using the Save button.  
 
 

5.3.14.2b) Import Survey Lines 
 
Import a comma-, tab-, or pipe-separated ASCII file with "StartLat", "StartLon", "EndLat", "EndLon" 
column headers. The survey lines will be drawn on the map and line numbers and cumulative distances 
will be calculated automatically in the table beneath the map. To calculate survey line duration, enter a 
ship speed in the Ship Speed box and hit Submit.  
 
 

5.3.14.2c) Sampling any grid using survey lines 
 
By default, when the GMRT global elevation model is loaded, the elevation values at the start/end of the 
survey lines are sampled and displayed in the table beneath the map. This functionality, in fact, applies 
to any loaded built-in or imported grid. An example using geoid heights and using gravity free-air 
anomaly data is given earlier in this section. 
  

https://www.gmrt.org/
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5.4) Focus Sites 

 

 
 
This menu provides quick links to data and information for the GeoPRISMS, MARGINS and Ridge 2000 
focus sites, as well as to other geographical study areas. 
 
Examples of available data and information include: high-resolution multibeam bathymetry grids, 
seismic interpretations, grids of magnetization; field station and instrument locations, geochemistry 
data and EarthChem tables, and vehicle dive photos. When viewing dive photos under the Focus Site 
menu, refer to the Seafloor Photographic Transects section. 
 

 
Figure: Examples of focus site data sets available directly from the Focus Sites menu. (Upper left: Central 
America rock samples giving collection information and field descriptions. (Upper right: Weinrebe’s 2008 
multibeam bathymetry compilation grid covering the Costa Rican margin, with sun illumination from the 
NW. (Bottom: At the Ridge 2000 EPR 9N study site, the seismic layer thickness grid of Canales et al. 
(2003) is made semi-transparent and overlain on the underlying multibeam bathymetry. PetDB rock 
sample analyses are colored by TiO2 value and scaled by silica content. 
 
Go to Table of Contents 
  

http://www.geoprisms.org/
http://www.nsf-margins.org/
http://www.ridge2000.org/
http://www.earthchem.org/
http://www.marine-geo.org/tools/search/entry.php?id=Central_America:Bathymetry_Weinrebe
http://www.marine-geo.org/tools/search/entry.php?id=Central_America:Bathymetry_Weinrebe
http://www.marine-geo.org/tools/search/entry.php?id=EPR_Canales
http://www.marine-geo.org/tools/search/entry.php?id=EPR_Canales
http://www.petdb.org/petdbWeb/index.jsp
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5.5) Overlays 
 

 
 
Look in the Overlays menu to plot distance/color scale bars, coastlines, lakes, rivers and geographical 
boundaries, latitude/longitude grid lines, UTM zones, and inset map controls. Toggle a feature on and 
off by selecting it in the menu. 

 
 

 
Figure: Overlain on this view of Europe are major lakes and rivers, coastlines, province boundaries, a 
color scale bar and a distance scale. The inset map and bathymetry credits have been turned off. The 
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distance scale is latitude-dependent and automatically changes when the cursor is used to move the 
scale to a different position. 
 
Some Overlay menu selections under Country Boundaries and Local Administrative Boundaries are 
controlled by a Shapefile Manager window which allows added functionality. If the Shapefile Manager 

does not automatically appear, click the Shapefile Manager icon  in the tool bar.  
 

 
Figure: Using the Shapefile Manager window, the province of Bourgogne and the country of Belgium 
have been highlighted. The 200 n. mile EEZ limits are also shown. 
 
In the above image, three boundary data sets have been loaded. They are listed in the left pane. The 

 box turns the layer on and off. In the example, two are displayed. The shape file that is 

currently active is highlighted in blue (here, ). 
 
The shapefile components are listed in the right pane. Click one of these components (here, 

) to illuminate that feature on the map.  
 

The Layer Manager tool (rightmost icon, , in tool bar) contains a tick box that turns the layer on and 

off ( ), discards the layer ( ), and allows the layer transparency 

to be altered via the slider bar . 

 
Go to Table of Contents 
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5.6) Education 
 

 
 
This menu provides links to various education web resources related to GeoMapApp: 
 

 
 

For example, under  are listed classroom-ready, freely-available, 
teacher-tested learning modules centred around GeoMapApp, including MARGINS mini-lessons. These 
education modules range in scope from middle school concepts to graduate student level. 
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5.7) Bookmarks 
 

 
 
The Bookmarks function allows users to specify the boundaries of predetermined geographical regions. 
Bookmarked places can be opened in future GeoMapApp sessions. If you wish to share the boundaries – 
for example so that every student in your class can open GeoMapApp at exactly the same view – use the 
Save Session function. 
 

 
 
 

5.7.1) Create a bookmark for the displayed map region 
 

Use  to create a bookmark the map region currently on display. The 
name for the bookmark is typed in the text box.  
 

 
 

By default the bookmark will be temporary. Select  to make the bookmark 
available for future GeoMapApp sessions. 
 

Bookmarked places are accessed in two ways. Click on  to bring up a 
navigation window listing the bookmarks. When a bookmark is selected, the map automatically zooms 

to that geographical region. The second way is to click on the  menu item. 
All bookmarked places are shown as rectangles on the map. Click in one of the rectangles to 
automatically zoom to that area. 
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5.7.2) Zoom to a specific geographical region 
 

When  is selected, the N, E, S, W boundaries are specified in the window that 
pops up. Note that the format is either decimal degrees or degrees minutes seconds. In either format, 
use negative for south or west values. For areas straddling the International Date Line, use longitude 
values in the 0-360 degree range. 
 

 
 
When the map has zoomed to the new place, note that the map area on display may not correspond 
exactly to the specified boundaries – the map is fitted into the aspect ratio of the GeoMapApp window.  
 
The new area on display can be bookmarked using the steps given above. Many bookmarks can be 
added to the GeoMapApp menu by repeating these steps. 
 

To delete a bookmark, use the  menu, select the bookrmark for deletion, 

and hit .  
 
For those interested, bookmarks are stored in a text file called My Saved Places.loc in a folder called 
places which is stored in the hidden .GMA folder.  
 

5.7.3) Zoom to the world map 
 

Return to the world map view using the menu item called .  
 
 
Go to Table of Contents 
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5.8) Window 
 

 
 
The Window menu lists all GeoMapApp function windows that are currently open and offers a quick 
way to bring them to the front. When one of the windows is selected from the list, it is automatically 
brought forwards. 

 

5.9) Projection 
 

 
 
Three map projections are currently offered in GeoMapApp: Mercator, south polar, north polar. The 
Projection menu offers a one-click way to switch from the current displayed projection to another 
without needing to close and re-open the program. 

 

5.10) Help 
 

 
 

Provides links to various help documents, video tutorials on , an FAQ page, a user forum, and 
this User Guide. There’s also a link for comments and feedback, and to sign up for the GeoMapApp 
announcements e-mail list. 

 
 
Go to Table of Contents 
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5.11) My Layer Sessions 

 

 
 
This menu exists only when the Sessions Manager is active. It provides access to the imported saved 

sessions. Use to import additional sessions. The  
button refreshes the list of locally-saved sessions. Here’s an example of the My Layer Sessions menu: 

 

 
 
In this example, three saved sessions have been imported. Moving the cursor over a saved session 
reveals its component layers. To help keep track of saved layers, each saved layer is associated with a 
color. In the following example, the session and its saved data sets are tagged with a green color. 
 

 
 
 

The  item removes the  menu from the top of the 
GeoMapApp window.  
 
For more information on saving a session, see also the Sessions Manager section and the How to Save a 
Session section.  
 

 
 
Go to Table of Contents 
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6) Guide to the Toolbar 
 

See video tutorial on  
 

    
 

6.1) Arrow Cursor  
 
Use the arrow cursor to select items on the map or items from loaded data tables. 
 

6.2) Pan  
 
When selected, click on the map and drag. This pan function offers an alternative to scrolling the map.  
 

6.3) Save  
 
The map window image may be saved in a number of image formats. When a grid has been loaded, 
additional options for saving the grid are presented. If the GMRT bathymetry/elevation synthesis base 

map grid is loaded, the menu item called  allows higher-resolution 
versions of the GMRT grid to be downloaded. The color scale bar for the base map or loaded grid may be 
saved using this Save function. This toolbar icon is equivalent to clicking File > Save Map Window as 
Image/Grid File. 

  

http://www.youtube.com/watch?v=2qb-gTRCc3I
https://www.gmrt.org/
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6.4) Zoom  

 

When zooming in  either click on the map or click-and-drag the cursor to define a rectangle on the 
map. When zooming out, click once the map for each zoom out operation.  
 
Note: when the cursor is in the map window, the ‘zoom factor’ is shown at the end of the tool bar 

display values. 
 
 

 
For many base maps and grids in GeoMapApp, the maximum native resolution is achieved at a zoom 
factor of 512. That was chosen to be equivalent to a pixel size of about 100m which is a typical value for 
the cell size for gridded multibeam swath bathymetry data. Going beyond that value merely stretches 
the image making the pixels bigger.  
 
However, a number of built-in grids and images have higher native resolutions and so can withstand 
further zooming. For example, in the continental United States, land elevations in the base map are 
derived from the 10m USGS NED data set and zoom factors of around 4,000 can be used to see stunning 
detail in the topography. 
 
Additionally, some grids derived from scanning sonar devices attached to dive vehicles have resolutions 
on the order of a few meters or better. In those cases, the zoom factor can be very large (around 
12,000) before pixilation becomes noticeable. 
 
 

6.5) Undo Zoom  

 

The 4 most recent zoom actions are stored in GeoMapApp. Click   up to 4 times to undo each zoom 
action in sequence.  
 
Go to Table of Contents 
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6.6) Profile/Distance tool  
 
Generate profiles across grids and find the distance between points using this function.  
 

 
Figure: Topographic profile across Mt St. Helens. As the cursor is moved in the profile window, the cursor 
location is displayed on the profile track as a small red. Save options for the profile are listed under the 
Save menu. 

 
6.6.1) Basic profile tool functionality 
 
Selecting the profile tool from the toolbar automatically loads the underlying GMRT global digital 
elevation base map comprising ocean depths and land topography. The profile line is defined by two 
points. Click once in the map window to specify the start point. Keep the cursor depressed and drag the 
cursor to the desired end point. Release the cursor to draw the profile line. A profile window 
immediately opens.  

https://www.gmrt.org/
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Alternatively, start and end points can be specified in the profile tool window using the start and end 
field: 

 
The default format of the start and end coordinates is decimal degrees but that can be changed to 
degrees and decimal minutes using the format drop-down menu: 

 
 
When in degrees and decimal minutes format, the hemispheres (N,S,E,W) for the start and end point 
latitudes (N or S) and longitudes (E or W) must be defined as shown here: 

 
 
Geographic position (in formats of degrees-decimal minutes and decimal degrees) and elevation are 
listed at the top of the profile window, along with the zoom factor. 

 
To change the axes scaling, untick the Auto-fit box, and type a scale into the window. Hit enter for the 
scaling to take effect. In the following example, auto-fitting on the y-axis has been disabled and a 
manually-defined y-axis scale of 4000m/inch is specified. 
 

 
 
By default, the profile is taken along a great circle line. Choose between great circle and straight line by 

selecting the radio button:  
 

6.6.2) Generate profiles across other grids 
 
The default setting for the profile tool is to generate a profile across the GMRT digital elevation base 
map. Profiles can be taken across any other built-in or imported grid regardless of what type of data is 
represented by the grid. See such an example here. 
 

6.6.3) Generate profiles through multiple grids 
 
The default setting for the profile tool is to generate a profile across the GMRT digital elevation base 
map. A vertical stack of co-located profiles can be generated when multiple grids are loaded. Up to four 
loaded grids can be profiled as a stack in this way, and the grids can be built-in grids, imported grids, or a 

https://www.gmrt.org/
https://www.gmrt.org/
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mixture. To exclude specific grids from being displayed in the stack, untick the Plot Profile tick box 

 in the Layer Manager window. 
 
In the following screenshot for the Juan de Fuca region, four grids have been loaded – the underlying 
GMRT global elevation model for seafloor bathymetry, and three gravity anomaly-related grids. The 
name of each grid is listed on each profile and the data type and units is the Y-axis annotation. 

 

https://www.gmrt.org/


    User Guide for GeoMapApp v3.7.1 

Page 104 of 164 

 

6.6.4) Vertical Exaggeration 
 
The profile is automatically exaggerated to fill the profile window. Defined as the x-axis scale divided by 
the y-axis scale, the vertical exaggeration (VE) is changed in one of three ways: 
 

 Type a new VE value into the text box and hit enter:  

 Untick the y-axis scale auto-fit box  , enter a new scale in the box 

 and hit enter. 

 Untick the x-axis scale auto-fit box  , enter a new scale in the box 

 and hit enter. 

 
 
6.6.5) Distance tool 
 
When the Profile Tool is active, click the cursor and drag it around the map. The distance from the 
original location to the cursor’s current location is instantaneously displayed in the upper bar of the 
main map window (to the right of the zoom factor): 
 

 
              ------------------------- 
When the cursor is released, the end point of the profile line is defined and the profile window pops up. 
 
 
Go to Table of Contents 
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6.7) Digitizer  
 
The digitizing function allows any loaded grid to be digitized. Digitized points may be moved around on 
the map dynamically and a profile may be generated. The points and profile can be saved. 
 

If a grid has not yet been loaded when the digitizer button is  clicked, the default underlying GMRT 
base map grid is loaded. If, however, a grid has already been loaded, that grid will be digitized instead. 
 

See video tutorial on  
 
When the digitizer tool is activated two things happen: Various panels appear in the GeoMapApp 
window, and the base map GMRT grid is loaded (unless another grid is already loaded). 
     

 
 

To begin digitizing, click on the  button.  The cursor becomes a cross-hairs 
(+). Click points on the map. To finish digitizing, either double-click the last point or click the Red Stop 

digitizing button .  
 

https://www.gmrt.org/
https://www.youtube.com/watch?v=ngwNcpa-FsE
https://www.gmrt.org/
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The line segments on the map turn white, with small squares at each digitized point. The digitized points 
are listed in the table beneath the map, along with the sampled grid values and distance columns. 
 

 
Figure: By default, the GMRT base map grid is loaded and digitized. If any other grid is loaded, its Z 
values will be displayed in the middle column. 
 
There are two ways to continue adding points to the ones that have already been generated, as follows.  
 
To add new points to the end of an existing digitized segment, click the Append to Segment button: 

. Doing so will re-activate the digitizing function. 
 
To add new points within an existing digitized segment, first activate one of the digitized points: Do this 
either by clicking on the point on the map or selecting a row from the table beneath the map. Once an 
existing point has been activated, it will turn red and the Insert Before Selected Point button is now 

available in the right pane: . Click that button and a message 
pops up to notify the user that the digitized points will temporarily disappear from the table whilst the 
new points are added. Click on the map to add new intermediate points. To finish adding new 
intermediate points, either double-click the point just added or click the red Stop Digitizing button. 
 

https://www.gmrt.org/
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To delete specific points click on the point on the map or select a row from the table beneath the map 

and then click the Delete Points button in the lower right:  

Delete an entire digitized segment with  
 

Save the digitized table with  
 
The digitized points are interactive - drag the points on the map or manually edit the Lat/Lon values in 
the table to move points (double-click the table cell to edit a value). In the example below, one of the 
points is dragged to the SSW. The table and profile are updated instantly to reflect the new positions. 
 

       
The ability to move the points either by dragging them on the map or manually editing the Lat/Lon 
values in the table allows the positions to be defined precisely. 
 
In the lower right, use the Draw Profile button to generate an interpolated profile between the digitized 
points.  

 
 
The elevation values are extracted from the loaded grid by interpolating 100 intermediate points 
between each pair of digitized points so that a smooth profile is generated. The interpolated points are 

displayed in the table when the  button is clicked. The profile can be saved as an 

image using the Save button in the lower right. Note that the Draw Profile option  must 
be active in order to save the profile as an image. 
 
Moving any of the points on the map will instantly change the profile. 
 
Save the table or profile using the Save button in the lower right. Any interpolated points will also be 
written to the saved file when the save table option is chosen. Example: 
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To digitize a new segment, click on the  button again. The previous 
segments turn black. The new segment is white. The digitized segments are listed in the panel on the 
right. Switch between the digitized segments by clicking the relevant segment name. 
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Digitizing any loaded grid 
 
By default, the Digitizer function extracts values from the GMRT base map digital elevation model. 
It can also be used to extract values from any grid that is loaded – whether the grid is one of the many 
built-in grids or is an imported grid.  
 
To digitize a grid, load it so that it is displayed in the map window, then begin digitizing. 
 
The example below shows the table beneath the map when a magnetic anomaly grid is loaded and 
digitized. Note that the magnetic anomaly value is listed in the middle column: 
 

 
 
 
 

All digitized points are lost when GeoMapApp is closed. Save them with  
if they are needed for future use. 
 
Go to Table of Contents 
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6.8) Shapefile Manager  
 
When a shapefile is loaded, the shapefile manager can be used to toggle the shapefile on and off, and, 
for multi-shape shapefiles, to select individual shapefile components. 
 
In the image example, below, two multi-shape shapefiles are loaded. Select one by clicking its name in 
the left pane, then select in the right pane which individual shapefile component to view.  

 
Figure: The multi-shape NOAA coastal grids shapefile is selected. Clicking the light bulb loads the grid for 
shapefile H10974. The multi-shape lakes shapefile, bc_2m_lakes, is also loaded. Click in the left pane to 
display its component shapefiles. Other examples of multi-shape shapefiles include built-in geographical 
boundaries data sets. 
 

For grid shapefiles, click the light bulb  to open the grid dialog  and click the 

zoom button  to zoom on the area covered by the shapefile. The information button  provides 
additional on-line information on the data set. The shapefile can be toggled on and off using the visibility 

buttons  . Discard the shapefile using . 
 
 

6.9) Focus  
 
In rare instances when the map view does not come into focus after zooming, click the focus button 

 to refresh the image. 
 
 
Go to Table of Contents 
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6.10) Mask function  
 

See video tutorial on  
 
GeoMapApp’s GMRT base map includes higher-resolution bathymetry and land elevation data from a 
number of sources including a large number of multibeam swath bathymetry data sets and regional 

grids, 10m USGS NED land elevations, coastal grids, and under-ice data. Clicking the mask function  
applies a transparent mask to reveal the location of this higher-resolution data. Semi-opaque grey areas 

indicate no higher-resolution data was used in the GMRT tiles. Click the mask function button  
again to discard the mask. 
 

    
 

    
 
Figure: (Top row) The GMRT base map (left) and the location of higher resolution data used in its 
creation (right). (Bottom row) When zooming, some areas look ‘fuzzy’ or lacking in detail (left, an 
example on the East Pacific Rise). The mask function (right) reveals areas of multibeam data (transparent 
mask); the grey areas were not refined using multibeam data. 
 
Go to Table of Contents 
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6.11) Loaded Grids window  

 
This shortcut loads the GMRT base map grid. When a grid is loaded, the Loaded Grids window allows 
other global grids to be quickly selected from the drop-down menu.  
 

 
 

 
Figure: Global grid of geoid height anomaly (Sandwell and Smith, 1997), with ten-meter contours, and a 
profile showing the remarkable 180m geoid height anomaly between the Indian Ocean and Indonesia. 
 
See the grid manipulation section for more information on grid functionality.  
 
Go to Table of Contents 
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6.12) Layer Manager  
 
Use the functions in the Layer Manager window to turn layers on and off, change layer transparency 
(opacity) and layer ordering, and discard layers.  
 

 
 
Turn the layers off/on by ticking or unticking the display box ( , ). Bring layers to the front by 

changing their order with the vertical arrows . Layer transparency is controlled with the transparency 

function – see below. Click the  box to discard the layer. 
 

6.12.1) Layer transparency 
 

Slide the Opacity slider bar ( ) to the left and right to alter the layer transparency. That allows 
convenient comparison with features on other layers. When the slider bar is all the way to the right the 
layer is opaque and so is fully visible. As the slider bar moves to the left, the layer becomes more 
transparent thus allowing other layers to become visible.  
 

7) Tool tips 
 
Many icons and table column headings contain active tooltips. Allow the cursor to linger over the item 
for a second or two to see the associated tooltip. 
 

 
 
Go to Table of Contents 
  



    User Guide for GeoMapApp v3.7.1 

Page 114 of 164 

8) Toolbar Text Display 

 

 
 
The displayed text varies with three cases.  
 
Case 1: No grid loaded (default view, or when images are loaded) 

 
 
From left to right, the text in this example shows:  
 
Longitude in whole degrees and decimal minutes, East or West (range is 0-180). 
Latitude in whole degrees and decimal minutes, North or South (range is 0-90). 
Longitude in decimal degrees, East or West (range is 0-180). 
Latitude in decimal degrees, North or South (range is 0-90). 
Zoom factor. This number indicates how far in we have zoomed. A zoom factor of 1 corresponds to the 
global view. For those interested, a zoom factor of 512 is the zoom level at which a 100m gridded data 
set can be viewed without obvious detrimental image pixelation. The USGS NED land elevation data set 
used in the GMRT base map has a resolution of 10m in the conterminous US and zoom factors of 2048 
or 4096 still offer good detail. Ultra-high-resolution grids at hydrothermal vent sites (some with grid cell 
size of just 25 cm!) can withstand even higher zoom factors, up to tens of thousands.  
 
Case 2: Grid loaded 

 
 
Same as case 1, but now shown to the right of the geographic location is the z value of the grid at the 
cursor location (-2733m in this example, 80.3 mY in the snapshot example shown at start of section). 
 
For many grids, the native grid resolution may support large zoom factors. 
 
Case 3: Profile tool activated (grid is loaded) 

 
 
Same as case 2, but now shown to the right of the zoom factor is the distance from the start of the 
profile to the current position of the cursor (418.45 km in this example). The Profile Tool thus provides a 
convenient distance-measuring function. 
 
 
Go to Table of Contents 
 

  

https://www.gmrt.org/
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9) GeoMapApp Tutorials on   
 

A range of short video tutorials is available on the GeoMapApp channel on  
 
The tutorials can be viewed in any web browser. 
 
 
Go to Table of Contents 
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10) Cookbook 
 
10.1) How to Import Data – Tables and Spreadsheets 
 

See video tutorial on  
 
ASCII data tables and spreadsheets in Excel .xls and .xlsx format may be imported to GeoMapApp.  
 

 
Figure: Example spreadsheet called TicoFlux2_Processed_Heatflow.xls contains NSF MARGINS-funded 
heat flow data collected by Andy Fisher in central America. 
 
The spreadsheet must contain a column for longitude (in decimal degrees between +/- 180) and a 
column for latitude (in decimal degrees between +/- 90). The first row of the spreadsheet is expected to 
be column headings.  
 
Spreadsheets containing dozens of columns can be imported successfully. Also, those containing simple 
formulae generally can be imported. If a spreadsheet fails to import, try converting it to a tab-, comma- 
or pipe-separated ASCII file and then use the appropriate ASCII table import option in the same menu. 
Note also that the old Excel 5.0/95 (BIFF5) format is no longer supported. 
 
Select the import function: 
 

 
 

http://www.youtube.com/watch?v=P4v2Mfz32X4
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Locate the file and Open it. After GeoMapApp reads the contents of the file, a Config window appears.  
 

  
 
GeoMapApp searches for a latitude and longitude column heading (it can recognise “Latitude”, 
“latitude”, “lat”, for example). If no match is found, the latitude and longitude columns must be 
specified in the Config window. Open the drop-down menu for Latitude Column and select the latitude 
column from the list. In this example, it is “Pen_Latitude”. 
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Similarly, select the longitude column. Click .  
 
When loading a tabular data set, the symbol color can be defined. Click the Color All button: 

 
In the Color Chooser window, drag the horizontal bars up and down to select a color. Hit OK to apply the 
color. Note that the color applies to all symbols. See lower down in this section for details on how to 
color symbols individually. 

 
 

The shape of symbols is chosen under the  menu. Like the symbol 
color, it applies to all symbols. 
 
Once the parameters have been set, hit the OK button to import the tabular data set. Two things 
happen. First, the symbols are plotted on the map and second, a table appears beneath the map.  
 
If there are no symbols on the map and no records beneath the map, it is likely that the geographical 
area displayed in the map window does not include the area covered by the imported data set. So, zoom 
out until the symbols and table are shown. 
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The table displays the contents of the imported data records for all locations that fall within the 
boundary of the map window.  
 

 
 
Widen the columns by clicking on the column border and dragging the double-headed arrow cursor. 
 

 
 
A panel containing function buttons appears on the right side of the map.  
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To color the symbols individually, there are two ways to proceed: interactively using the 

 button or manually be including a column of Red,Green,Blue values in the 
imported file. 
 

For the first way, click  and choose a parameter on which to color (e.g. by heat 
flow value). The color histogram window shows the selected value along the x-axis and the number of 
values on the y-axis. Drag the vertical grey lines sideways with the cursor (double-headed arrow) to 
change the color range.  
 

 
 
For the second way, a specific color can be defined within the imported file by creating one column that 
contains Red,Green,Blue comma-separated values. For example, to define a record’s symbol as yellow, 
the RGB value for it would be 255,255,0. 
 
 

Change the symbol Shape with  Choices are: Circle, square, star, triangle.   

 
 
 
Lines Versus Points 
 
By default, tabular data sets are displayed as points on the map. A continuous line may be used to join 

the points and is activated in the Configure window by selecting the “Track” radio button:    
 
The default color for the track line is grey. Use the Line Thickness and Line Style parameters to control 
the appearance of the line, and use the Symbol/Line Color function to change color: 
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The example below shows an imported ASCII data table that contains the location of the Japan Trench 
(data courtesy of Dallas Abbott, LDEO, 2023). On the left, the imported points are plotted as points, here 
colored yellow. On the right, the same points are plotted as a continuous, thick yellow line. 
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When drawing a line between the points, the “greater than” segment separator symbol (“>”) may be 
used to distinguish separate segments within an imported ASCII file. Any row in the ASCII table in which 
the first character is “>” will be treated as a segment separator. The line is broken at the segment 
separator so that lines are drawn only between points within each segment.  
 
Example of imported, tab-delineated ASCII table with segment separators: 
 
Lon Lat   length_km az_of_line velocity_mm/a    az_of_velocity     depth_m   age_ma   Name 
153.108 -8.684 12.9 148 13 230 -3853 220 Trobriand Trench 
153.237 -8.89 33 177 13 230 -3122 220 Trobriand Trench 
153.255 -9.186 0 177 13 230 -3122 220 Trobriand Trench 
>         
156.296 -8.174 29.8 141 98.1 255 -3210 220 D'Entrecasteaux Arc 
156.467 -8.382 33.1 127 97.8 255 -2051 220 D'Entrecasteaux Arc 
156.706 -8.563 9.4 117 97.6 255 -2963 220 D'Entrecasteaux Arc 
 

 
 
Go to Table of Contents 
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10.2) How to Lasso Data Points 
 

When tabular data is loaded, click the lasso tool  to activate the selection function. 
Move the cursor to the map window, click and hold the cursor button, and draw around the points of 
interest. 
 

    
The selected points are highlighted in white on the map, and in blue in the data table below the map 
window. 
 

  
 
Save these chosen points in a range of formats using the right-pane Save function. 

 
 
 
Go to Table of Contents 
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10.3) How to Import Data – Grids 
 

See video tutorial on  
 
Gridded data sets can be imported in GeoMapApp in various formats: GMT netCDF , ESRI ASCII or ESRI 
binary , Geodas GRD98 or ASCII Polar (.asc). Grids may be in Geographic or UTM projection. 
 
Grids can be imported either separately one at a time or as a one group. The example below shows how 
to import multiple grids at once. The multiple grids must reside in the same folder. 
 

 
Figure: List of netCDF grids constructed from JAMSTEC research vessel Kairei processed multibeam swath 
bathymetry data collected in 2003. 
 
Activate the import-grid function: 

 
Specify the grid type from the drop-down menu and click OK: 

 
 

http://www.youtube.com/watch?v=JnXJ-Y8Ry0s
http://gmt.soest.hawaii.edu/
http://www.unidata.ucar.edu/software/netcdf/
http://en.wikipedia.org/wiki/ESRI_grid
http://en.wikipedia.org/wiki/ESRI_grid
http://www.globalmapper.com/product/formats_elevation.htm#Geodas_Grid_GRD98_Format
http://www.unidata.ucar.edu/software/netcdf/
http://www.jamstec.go.jp/e/
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In the file system navigation window, navigate to the folder containing the grids 

 
 
Use the cursor (shift-click) to select one or more of the grid files. (To import just one grid, select that grid 
file name only.) The file names of the selected grids turn blue. 

 
 

Click   
 
When importing grids, a Confirm Projection and Bounds window like one of those shown below appears. 
It displays header information for the grid/grids to be imported and requires some user input. The 
information extracted from the header includes the grid projection (UTM or geographic), the number of 
grid nodes (nx, ny), the west/east/south/north bounds, and min/max Z values.  
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Here is an example of grid import window for UTM grid. GeoMapApp recognises that the grid is in UTM 
projection but the user must specify the UTM zone as an integer in the yellow text box. The hemisphere 
is specified by selecting the N or S radio button. For example, for UTM zone 10N, type 10 in the yellow 
zone box and click the N radio button: 
 

 
 
The other options presented in this import window are described below. 
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And this is an example of grid import window for multiple grids that are in Geographic projection. 
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For both UTM and Geographic grids, a range of import options are available.  
 
Flipped grids 
Grid arrays are typically loaded from the southwest corner to the northeast corner. For grids that are 
loaded the other way, they will be displayed upside down and in the wrong geographical location. To 
correctly import the grid, click the "Tick to flip grid along horizontal axis" box: 

 
 
If an upside down grid was imported it is necessary to remove some local files before importing it 
correctly. First, you will need to delete the local tiles that were created when the grid was imported. 
That is because the local tiles are appended and not overwritten when subsequent grids are imported. 
To delete the local tiles, go to the folder in which the grid resides. You will see some "z_nnn" folders 
with names like z_1024 and z_512. Delete all of those "z_nnn" folders. You will also see some shapefile 
components (.shx, .shp, .dbf, etc). Delete those shapefile components, too. Only the original grid/grids 
should remain in that folder. Second, now that the incorrect local tiles have been deleted, the grid may 
be imported once more. This time, though, in the Confirm Projection and Bounds pop-up window, click 
the box labelled "Tick to flip grid along horizontal axis". The imported grid should now be displayed in 
the correct geographical location in the map window. 
 
Data type, units, scale factor, offset 
The data type and units for an imported grid may be specified in the Data type and Units for Z values 
boxes. The units are then displayed in the top bar of the GeoMapApp window. And both the units and 
data type are displayed if a profile is generated from the grid.  
 

The gridded Z values can be scaled by any factor using the  option. This is useful for 
switching depths from positive downwards to negative downwards, for example (by scaling by -1.0). A 
DC shift may be added to the Z values using the Add Offset box. 
 
NoData values 
Typically, grids are coded so that any cells with NoData will have a value of “NaN” (Not a Number). For 
grids in which the NoData value is not NaN, use the NoData Value box to type in the value. For example, 
for a grid in which a value of 128 is used for NoData, type 128 in the box. 
 
Edit grid 

The  box allows the min/max Z values of the current grid to be manually edited.  
 

To manually edit or scale individual grids within the group of grids to be imported grids, click  - 
the Confirm Projection and Bounds window will display the grids information one grid at a time. 
 
Import multiple grids 
To import all of the grids at once (and to apply the same scaling factor to all of the selected grids), tick 

the  box. Check that the bounds listed in the lower part of the window are 
sensible. For example: 
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Then, click    
 
 
As each grid is processed, its status is shown in the Import Grid window. 
 

 
 
When all of the grids have been processed the folder containing the grids now includes a set of z-folders 
and a suite of shapefile components. These new files and folders should not be discarded at this stage - 
the shapefile allows the imported grids to be accessed instantly at a later date, and the z-folders allow 
zoom capability. 
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Two new GeoMapApp windows appear – a grid dialog and a shapefile manager – and the map window 
zooms automatically to the gridded area. 
 

    
 

 
 
The wide range of GeoMapApp grid manipulation functions can now be applied to these imported grids 
– changing the color palette, sun illumination, vertical exaggeration, adding contours, taking profiles, 
overlaying imported data points, saving images, and so on. 
 
If you would like your grid to be built into the GeoMapApp base map or the GeoMapApp menus, please 
contact us. 
 
Note that imported grids are loaded for the current GeoMapApp session only. But, there is a quick way 
to re-load them – simply import the shapefile and the grid will instantly be displayed. The shapefile may 
be imported under File > Import an ESRI Formatted Shapefile, as described in this section. 
 
 
Go to Table of Contents 
 
 

  

http://www.marine-geo.org/about/contact.php
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10.4) How to manipulate grids 
 

See video tutorial on  
 
When any grid is loaded, two windows pop up: the grid dialog window (shown at left, below) and the 
Layer Manager (shown at right, below). 
 

    

 
In the grid dialog window, the histogram shows the relative distribution of gridded z-values for the map 
area displayed in the map window. For example, for a relatively flat area, the color histogram will show 
a narrow distribution of gridded z-values. In contrast, a map area that includes a wide range of z-values 
will yield a histogram that is broad.  
 
The color scale is automatically adjusted so that the palette spans the full range of gridded z-values 
displayed in the map. To change the span of the colors, drag the two thin, grey vertical lines to the left 

http://www.youtube.com/watch?v=DBtj_EdMJDM
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or right – the cursor will become a double-headed arrow that can be dragged. The map will refresh 
instantly with the new range of colors. Reset the color range to the default by clicking the normalizing 

button . The chosen limits can be locked with the  button. This preserves the limits when the 
map window is zoomed or panned.  
 

The “ocean palette” button  is a shortcut to a color palette suitable for z-values between 0 to about -

8000 (typical ocean depth ranges). The  “land palette” button  is a shortcut to a color palette 

suitable for z-values between 0 to about +6000 (typical land elevations). The  button switches to the 

default palette that spans both positive and negative ranges. The continuous rainbow button  
spreads the color scheme uniformly across the z-range of the grid. Discrete color changes are specified 
with the bar chart button – specify the increment for the color change boundaries by typing in the 

associated text box: .  
 

 
 

Click the  button to choose from amongst 65 built-in palettes or to create or save a 
custom palette. The full suite of available built-in palettes is displayed by clicking Palettes Menu > More 
Palettes, as shown here: 
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Available built-in color palettes: 
 

 
 
In all palette-related functions, two thin grey vertical lines displayed in the histogram window can be 
dragged left or right to change the color range.  
 
The right-side of the grid dialog window controls the artificial sun illumination of the grid display. 
Change the illumination angle and brightness by dragging the yellow sun symbol. Precise illumination 
angles can be specified by typing degree values into the text boxes.  
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The intensity of shading is determined by the vertical exaggeration which is specified in the  
box. 
 

To lock the area displayed on the map, click the padlock symbol . That is useful if additional data sets 
with different bounds are loaded. 
 

Switching between the ‘below zero’ , ‘above zero’  and ‘continuous’  color palette buttons 
allows different z-ranges of the grid to be colored and shaded independently. For example, that can be 
useful for applying different coloring/shading settings to a map display that includes ocean floor depths 
and land elevations.  
 

The  button switches the histogram between the distribution of elevations (or whichever z value is 
represented in the grid) and the distribution of gradients. 

To draw contours on the grid, click the contour  button to open a contour parameters box. 

 
 

Specify the contour interval and the maximum/minimum values to be contoured. When the  
button is clicked, the contours are processed on the local CPU and displayed on the map. The contours 
can be turned off by clicking the contour button again. 
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Figure: Hawaiian islands free-air gravity anomaly grid with contours displayed at 10mGal intervals. An 
upper contour limit of 100mGal was imposed. The white line is the location of the profile, shown below. 

With any grid loaded, profiles are generated using the profile function . Once clicked, the cursor 
becomes active as a profiling tool. Drag the cursor across the map window to draw a profile line. 
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Figure: Flexural moats around the Hawaiian islands shown in this profile of the Sandwell-Smith satellite-
derived free-air gravity anomaly. 
 

In the grid dialog window, click the information button (  in the upper left) to open a web page with 
more information about the loaded grid. 
 

To reload or discard the grid, click the  buttons.  
 

The grid that is visible in the map can be saved in many different formats using the save button . The 
map can also be saved as an image.  
 
Most of the grid-save options will save the grid at the resolution of the map window. However, when 
the GMRT base map grid is loaded, a range of grid resolution options is available by selection the      

Grid: Higher Resolution Options:  
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The grid can be viewed in 2-D or 3-D, controlled with the  selection. When  is 
selected, a 3-D perspective viewing window is opened. It shows a low-resolution version of the grid and 
allows various parameters to be altered.  
 

 
 

Rotate the grid using the  button (drag cursor left or right in the preview image). Tilt the surface with 

 (drag cursor up or down in the preview image). Zoom in or out with the zoom  button (in 
preview image, drag cursor to the right to zoom out, and to the left to zoom in). Change the vertical 

exaggeration by typing the factor into the  box. Specify the pixel size of the fully-rendered 
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image – the default 700 x 500 pixels works well with most laptop screens). Click 

 to produce the full-resolution 3-D perspective plot. 
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10.5) How to generate multiple profiles 
 
The ability in GeoMapApp to layer multiple data sets can be used to generate a stack of co-located 
profiles through multiple grids. Up to four loaded grids can be profiled as a stack in this way, and the 
grids can be built-in grids, imported grids, or a mixture.  
 
In the following example for the Juan de Fuca region, four grids have been loaded:  
 

 The underlying GMRT global elevation model for seafloor bathymetry. Click the grid load 

shortcut in the toolbar to quickly load this:  

 Gravity free-air anomaly (FAA) grid from Hooft and Detrick (1995) 

 Gravity mantle Bouguer anomaly (MBA) grid from Hooft and Detrick (1995) 

 Gravity residual mantle Bouguer anomaly (RMBA) grid from Hooft and Detrick (1995) 
 
The three gravity-related grids are built-in data sets. Find them under DataLayers > Geophysics > Gravity 
Anomalies and Geoid heights > Gravity Anomalies > By Region.  
 
The grids can be loaded in any order – use the up/down arrows on the right side of the Layer Manager 
window to change the order. 

 
To exclude specific grids from being displayed in the stack of profiles, untick the Plot Profile box in the 

Layer Manager window, as shown here:  Only those profiles with ticked boxes will be 
displayed. By default, profiles for all grid layers are displayed, up to the maximum of four profiles. 

https://www.gmrt.org/
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The screenshot below shows the grids loaded in the map display. As shown in the Layer Manager, the 
RMBA grid is the top-most grid. The color palette was changed from the default to the “jet2” palette.  
 

In the toolbar, click the  button to activate the Distance/Profiling tool. Then draw a profile line – it 
will be displayed in white on the map. 
 

 
 
The vertical stack of co-registered profiles will be displayed in a new window, and the grid name is listed 
beneath each profile, like this: 
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Use the Save button in the upper left to save the profiles as an image file or as an ASCII data table. 
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10.6) How to sample a grid at user-specified points 
 
Any 2-D loaded grid, whether built-in or imported, can be sampled at specific points using either the 
digitizer function or the Waypoints and Survey Lines portal.  
 
To sample a grid at a small number of points or where only approximate values are required, the 
digitizer function may be the simplest approach. By default, the digitizer function will sample the GMRT 
global elevation model. If any other grid has been loaded, that other grid will be sampled instead. See 
the Digitizer section for more information.  
 
To sample a grid at a large number of points or where precision is required, the Waypoints and Survey 
Lines portal allows a file of user-specified points to be imported. In the portal, the points are referred to 
as waypoints. In this manner, the GeoMapApp waypoints portal provides a grid sampling capability 
similar to the 2-D grid sampling function offered by the GMT grdtrack program. By default, the 
waypoints portal will sample the GMRT global elevation model. If any other grid has been loaded, that 
other grid will be sampled instead. See the Waypoints and Survey Lines portal section for more 
information. 
 
In either approach, the digitized or imported points are interactive - drag the points on the map or 
manually edit the Lat/Lon values in the table to move points (double-click the table cell to edit a value).  
 
 
Go to Table of Contents 
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https://www.gmrt.org/
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10.7) How to use the Layer Transparency 
 
Layer transparency can be changed to allow other layers to become visible. This is useful for comparing 
data sets in different layers. In the following example, we compare satellite-derived free-air gravity 
anomalies for the Hawaiian islands with the regional bathymetry – we might want to do this when 
studying lithospheric flexure.  
 
Zoom to the Hawaii region and load a gravity FAA data set (here, we use the tear-off menu option to 
simplify the menu navigation). 
 

  
 
In the Layer Manager window, toggle the gravity data set off and on by unticking/ticking the ,   box.  
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Slide the Opacity slider bar ( ) to alter the transparency of the layer. When the bar is all the way to 
the right the layer is opaque. As the slider bar is moved to the left, the layer becomes increasingly 
transparent allowing the other layers to become visible. When the slider bar is all the way to the left 
(equivalent to unticking the  box), the layer is completely transparent (invisible) and the underlying 

layer is fully visible. Click the discard box  to discard the layer.  
 

        
Figure: (Left) Layer is opaque and fully visible. (Middle) As opacity decreases, the underlying GMRT 
bathymetry becomes visible. (Right) When fully transparent, the original layer is no longer visible, 
allowing the GMRT layer to be displayed fully. 
 
 
Go to Table of Contents 
 
 

  

https://www.gmrt.org/
https://www.gmrt.org/


    User Guide for GeoMapApp v3.7.1 

Page 145 of 164 

10.8) How to Import Data – Shapefiles 
 

See video tutorial on  
 
Shapefiles usually comprise a number of component files. To import  a shapefile to GeoMapApp, the 
following component files must be present: .shp, .shx, .dbf. 
 
Activate the import-shapefile function: 

 
 
Navigate to the folder containing the shapefile component files and check that the .shp, .shx, .dbf are 
present. In this example, a shapefile contains the outlines of lakes at 2m resolution for British Columbia. 
 

Select the .shp file ( ) and click    
 

 
 

http://www.youtube.com/watch?v=noRwgqiEYC4
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A Shapefile Manager window appears. The shapefile contents are listed in the right panel of the 
Shapefile Manager, and the layer is displayed on the map.  

 
 
In the right panel, click on an item in the list to highlight that feature – on the map, the feature turns 
white. 

   
Figure: Close-up of British Columbia lake outlines. (Left) Shapefile component is selected (highlighted in 
white). (Right) Item is de-selected (outlined in black). 
 
 
Go to Table of Contents 
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10.9) How to Import Data – Shapefiles of grids 
 
When grids are imported to GeoMapApp, the import procedure automatically generates a shapefile of 
the grid. This shapefile can be imported at a later date without having to re-import or re-process the 
original grid.  
 
Follow the steps above for importing shapefiles. Since the shapefile content is a grid, the grid dialog 
window also appears. 
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10.10) How to Save a Session 
 
GeoMapApp offers a Session Manager capability to save, share, and re-use a pre-loaded state of 
GeoMapApp. That can be useful and efficient when teaching, collaborating or simply as a convenient 
means to pick up where you left off.  
 
The Session Manager function captures the loaded data layers and data portals, the map location, and 
zoom, any color palette, contouring and shading parameters, any layer transparency settings, and, for 
tabular data sets, any symbol color and scale choices. The information is stored as a small XML file that 
can be shared with colleagues and students. When a saved session file is imported, GeoMapApp 
automatically zooms to the geographical area and displays all of the previously-loaded data layers in the 
same way that they had been saved, including any coloring, contouring, scaling choices. 
 
In teaching, a saved session could be shared with a class allowing every student to open GeoMapApp at 
exactly the same starting point from which to begin their data explorations.  
 
The Session Manager menu is under the File menu (File > Session Manager). It offers the following 
options: 

            
 
Save the current display using the Save Current Session option. The saved information is stored in a 
simple, small XML file on the local machine. The name of the saved session file is, by default, 
constructed from the user name and a date and time stamp. Example: “Session_andrewg_2019-04-
23_16-56-56-GMT-0400.xml”. The files can be manually renamed if desired.  
 
The contents of the saved session XML file tell GeoMapApp which data sets and display options are 
being used. For teaching or collaborating, that XML file is the one to share. 
 
Most built-in data sets can be captured in the save session file. Note that any imported data sets such as 
any imported tables, spreadsheets, grids or shapefiles are excluded because there is no way to capture 
their content in the simple save session XML file. 
 
In the Cascadia region example below, four built-in data sets have been loaded. (a) In the background, 
the bright reds and blues display a grid of shear wave seismic velocity data from a tomographic depth 
slice. (b) Overlain on that is a grey-shaded grid giving depth to the top of the subducting slab, with 
contours. (c) The outlines of state boundaries. (d) Geochemical data plotted as circular symbols that are 
colored on one analytical parameter and scaled in size on another parameter. 
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This snapshot state of GeoMapApp can be preserved by saving the session using File > Session Manager 
> Save Current Session. This action will save a small XML file on the local computer: 

 
 
To import a saved session at a later time, go to File > Session Manager > Import Saved Session and 
navigate to and import the saved session file. 
 
When the session file is read, the map will automatically zoom to the area and all of the associated data 
sets and data portals will be loaded. Any saved contour, transparency, color and symbol size scale 
options will be applied automatically. (Depending upon the speed of your internet connection and the 
data sets and portals being accessed, that may take a minute.)  
 
When all of the components of the imported session have been loaded and displayed, a new menu 
called My Layer Sessions appears in the menu bar at the top of the GeoMapApp window.  
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Initially, the My Layer Sessions menu name is shown in orange to highlight its presence. Once the menu 
has been accessed, the orange color is removed.  
 
The My Layer Sessions menu lists the imported session and, when the cursor hovers over the session 
name, its component data sets are listed in a cascading menu on the right, like this: 
 

 
 
On the right, the individual components in the saved session are listed in the same data layering order 
as in the original session. Individual layers may be loaded by clicking them. Or, all data sets can be 
loaded by selecting Load All Layers. 
 
Additional sessions may be imported, either using File > Session Manager > Import Saved Session or via 
the My Layer Sessions menu (My Layer Sessions > Import Another Session). 
 
When more two or more sessions have been imported, the sessions are displayed in a list. The most 
recently-imported session is listed at the top. This list allows users to switch from one saved session to 
another. In the example below, two sessions are listed on the left. The data layer components for the 
most recent session are shown in the cascading menu on the right: 

 
 
Each imported session is tagged in the My Layer Sessions menu with a specific color in the component 
list to help distinguish one imported set of layers from another. 
 
When multiple sessions have been imported, it is occasionally necessary to use the up-down arrows in 
the Layer Manager window to move the layers to the desired layering order. 
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The Close and Discard My Sessions Menu option removes the My Layer Sessions menu from the menu 
bar (the saved session files remain stored on the local machine). When the My Layer Sessions menu is 
discarded, the loaded data layers and zoom remain – they can be separately discarded using the Layer 
Manager window.  
 
See also the My Layer Sessions section.  
 
 
Go to Table of Contents 
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10.11) How to use the Tear-Off Menus, and search 
 
Sometimes, navigating the GeoMapApp cascading menus can be frustrating if the item of interest is 
embedded deep within the menu structure. Tear-off menu functionality can help. It generates a simple 
menu navigation window that remains open and active throughout a GeoMapApp session. It also offers 
a basic search capability. 
 
Tear-off menus are available for the DataLayers, Portals, Focus Sites, Overlays, and Education menus. 
 

To activate the tear-off menu function, click  which turns blue 
when moused over. 
 

 
 
The corresponding menu navigation window opens, as shown below. In the menu navigation window, 

open a folder by either double-clicking the folder symbol ( ) or clicking the turn-down widget ( ).  
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To load an item, select it from the menu listing and click the  button. 
 
Tear-off menus also allow folders to be opened in separate navigation windows. Drag the folder out of 
the navigation window. The folder instantly opens as a menu in a new, active window. Sub-folders are 
again active. 
 
To search for a particular data type within each main GeoMapApp menu category, enter a key word in 
the tear-off menu textbox and hit the Enter key. In the example shown below, the DataLayers tear-off 
menu is open and a search for data types related to “temperature” will highlight all of the relevant 

menu items. Click one of the menu items and the  button to load it in the map window. 
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10.12) How to move and sort tabular columns 
 
With any tabular data set loaded, the rows within a column can be sorted in ascending or descending 
order by clicking on the column header. The order of columns can be changed by clicking on the column 
header and dragging the column left or right. 
 

 
 

 
Figure: For this ISC data set, the original configuration of the tabular data is shown in the upper panel. 
Beneath it, the latitude, longitude, magnitude and depth columns have been moved to the left, and the 
magnitude column has been sorted in ascending order. 

 
 
Go to Table of Contents 
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10.13) How to plot tabular data as a track instead of points 
 
By default, tabular data, whether built-in or imported, is plotted as grey circles on the map (shown on 
the left below). The Configure button (circled in red) provides control over the size, type and color of the 
symbols. It also allows the points to be joined by a line, thus creating a track (shown on the right below). 

   
 
To switch to a line, open the Configure window and select Track. In this example, the track is colored red 
(Color All) and drawn with a solid line with thickness of 4 (default is a grey line, thickness 1). 
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When plotting tabular data in track mode, the default is to join the points sequentially with one 
continuous line that runs from point to point.  
 
Segment separators may be used to split the line into separate segments. The “>” character is used in 
the file to indicate the start of a new segment (it tells GeoMapApp to lift the pen). In the tab-delimited 
ASCII data table below, a comment line (starting with the “#” character) is used for naming three 
segments: Segment 1, Segment 2, Segment 3. The segments are defined with the “>” character. The “>” 
character must be on its own line and must be followed by a data line. For this reason, it is necessary to 
put any comments such as the segment names on the line before the segment separator. Note that it is 
unnecessary to have a segment separator at the top of the file.  
 

 
 
 
When plotted in Track mode, the segment separators split the track into three segments, here plotted 
as pink solid lines: 

 
 
It may be preferential instead to plot the line segments in different colors. For that, an RGB column must 
be added to the table. The RGB column gives the comma-separated Red,Green,Blue values (in the range 
0-255). In the example below, an RGB column was added to color the first segment red, the second 
segment green, and the third segment blue. 
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The RGB column coloring also works when plotting the data table as points (in the Configure window, 

switch back to  to plot points). Here the symbols are changed from default circles to triangles: 

  
 
Go to Table of Contents 
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10.14) How to Detach or Re-Attach Tables 
 

When any tabular data set is loaded, click  in the upper right. This detaches the 
table, allowing the map window to become larger and the self-contained table to be moved around the 
screen. 

 
Example of free-floating, detached table, in this case for the IODP web feature service. 

Click  to re-connect the table to the map window. 
 
 
Go to Table of Contents 
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10.15) How to load data sets with many points 

 
For large data sets, GeoMapApp displays a notice if there are more than 20,000 points asking if all points 
should be plotted or just a decimated set. In this example, the data set contains 162,843 records: 
 

 
 
If Plot All Records is chosen, all of the points will be plotted on the map. For very large data sets, more 
memory may need to be allocated to GeoMapApp may have to be started – see the details in the 
Download and start GeoMapApp section. 
 
If Plot Geographically-Decimated Subset is chosen, all of the records will be read into operating memory 
but no more than 20,000 points will be plotted in the map window. The displayed decimated points are 
chosen to be representative of the geographical distribution of the entire data set although some quirks 
are known to occur. Do not worry – the hidden points have not been lost. Upon zooming in, more of the 
points become visible. 
 
Although modern computers tend to contain high-performance graphics cards compared to older 
computers, the decimation option is still provided for users who may be using older machines. 
 
GeoMapApp now allows the display parameters for multiple tabular data sets to be visible at the same 
time. So, the display parameters for one tabular data set will be preserved and will remain visible when 
a second tabular data set is loaded. To help distinguish one tabular data set from another, we 
recommend that you use a different symbol for each data set. To select a symbol click the Configure 
button in the right pane and choose from circle, square, triangle and star. 

 
Go to Table of Contents 
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11) Miscellaneous 

 
11.1) GeoMapApp Built-In Data Sets 
 
GeoMapApp offers a wide range of research-grade built-in data sets covering a broad array of 
geoscience fields. The built-in data sets are presented through the DataLayers menu.  
 
The data sets may be explored by navigation through the cascading menus or by searching the menus 
using key words, as described in this section. 
 
A web page lists recently-added data sets:  http://www.geomapapp.org/data_set_news.html 

 
 
In addition, some remote data sets that are served via web feature or web mapping services such as 
those served by federal agencies or data repositories are available through the following two menus: 
 
File > Import Data Set from Web Feature Service (WFS) 
File > Import Image from Web Map Service (WMS) 
 
 
Go to Table of Contents 
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11.2) GeoMapApp Image Gallery 
 
A number of compelling GeoMapApp images are available via MGDS MediaBank which can be accessed 
via the Image Gallery link on the GeoMapApp web page. 
 

 
 
 

http://www.geomapapp.org/gallery/index.html
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11.3) Citing GeoMapApp 
 

When citing cite GeoMapApp, please reference its use and include the URL 

http://www.geomapapp.org/  in text and figure captions.  

If you generate a map or image using the default base map, the Global Multi-Resolution Topography 
(GMRT) Synthesis, please also cite Ryan et al., 2009  in your paper’s reference list. 

Ryan, W.B.F., S.M. Carbotte, J.O. Coplan, S. O'Hara, A. Melkonian, R. Arko, R.A. Weissel, V. Ferrini, A. 
Goodwillie, F. Nitsche, J. Bonczkowski, and R. Zemsky (2009), Global Multi-Resolution Topography 
synthesis, Geochem. Geophys. Geosyst., 10, Q03014, doi:10.1029/2008GC002332. 

 
Additionally, you may wish to cite the GMRT web page:   
https://www.gmrt.org/ 
 
 
 

11.4) Frequently-Asked Questions 
 
A regularly updated FAQ page is available, here: http://www.geomapapp.org/FAQ.html 

 
 
11.5) User Forum 
 
A user forum is available for users to post questions and comments: http://forum.geomapapp.org/ 
The forum currently hosts more than 60 topics and has more than 200 posts. 

 
 
11.6) Contact us, and the GeoMapApp listserv 
 
Questions about GeoMapApp, as well as suggestions for improvements and notification of any bug, 
should be sent to info@marine-geo.org 
 
To join the GeoMapApp mailing list, go to the Mailing List link under the Help menu. 
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